Panasonic

iDEH AL Operating Instructions

Gostar

Network Camera

waeino. VWV-S2500 Series
WV-S2200 Series
WV-S2100 Series
WV-S1500 Series
WV-S1100 Series

WV-S1531LN WV-S1131

This manual covers the models: WV-S2500 Series (WV-S2531LTN, WV-S2531LN, and WV-S2511LN), WV-S2200
Series (WV-S2231L and WV-S2211L), WV-S2100 Series (WV-S2131, WV-S2131L, WV-S2131LPJ,
WV-S2131LRF, WV-S2131LEG, WV-S2111L, WV-S2110, and WV-S2130), WV-S1500 Series (WV-S1531LTN,
WV-81531LNS, WV-S1531LN, WV-S1531LNPJ, and WV-S1511LN), and WV-S1100 Series (WV-S1132,
WV-S81132RF, WV-S1132EG, WV-S1112, WV-S1131, WV-S1131PJ, and WV-S1111).

Before attempting to connect or operate this product, please read these instructions

carefully and save this manual for future use. s"/m

The model number is abbreviated in some descriptions in this manual. X


https://www.idehal.org/

Preface

Preface

About the user manuals

There are 3 sets of operating instructions as follows.

* Operating Instructions (this document): Explains how to perform the settings and how to operate this
camera.

* Important Information: Provides information about the cautions required for safely using and installing this
camera.

* Installation Guide: Explains how to install and connect devices.

The screens used in these operating instructions show the case of WV-S1131. Depending on the model used,

the screens shown in the explanations may differ to the actual camera screens.

About notations

The following notations are used when describing the functions limited for specified models.
The functions without the notations are supported by all models.

EEE“R: The functions with this notation are available when using the model WV-S1132, WV-S1132RF,
WV-S1132EG, and WV-S1112.

EEXEB: The functions with this notation are available when using the model WV-S1131, WV-S1131PJ, and
WV-S1111.

((S15x1 J: The functions with this notation are available when using the model WV-S1531LTN, WV-S1531LNS,
WV-S1531LN, WV-S1531LNPJ, and WV-S1511LN.

825x1: The functions with this notation are available when using the model WV-S2531LTN, WV-S2531LN,
and WV-S2511LN.

&2 : The functions with this notation are available when using the model WV-S2231L and WV-S2211L.
& : The functions with this notation are available when using the model WV-S2131, WV-S2131L,
WV-S2131LPJ, WV-S2131LRF, WV-S2131LEG, and WV-S2111L.

&P : The functions with this notation are available when using the model WV-S2110 and WV-S2130.
EEEE®: The functions with this notation are available when using the model WV-S1132, WV-S1132RF,
WV-S1132EG, WV-S1131, and WV-S1131PJ.

EEXEET8: The functions with this notation are available when using the model WV-S1112 and WV-S1111.
((S153x J: The functions with this notation are available when using the model WV-S1531LTN, WV-S1531LNS,
WV-S1531LN, and WV-S1531LNPJ.

((S151xJ: The functions with this notation are available when using the model WV-S1511LN.

(8253x): The functions with this notation are available when using the model WV-S2531LTN and
WV-S2531LN.

C8251%: The functions with this notation are available when using the model WV-S2511LN.

&&ZE®: The functions with this notation are available when using the model WV-S2231L.

&&ZEP®: The functions with this notation are available when using the model WV-S2211L.

& : The functions with this notation are available when using the model WV-S2131L, WV-S2131LPJ,
WV-S2131LRF, WV-S2131LEG, WV-S2131, and WV-S2130.

@&EP®: The functions with this notation are available when using the model WV-S2110 and WV-S2111L.
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Abbreviations

The following abbreviations are used in these operating instructions.

Microsoft® Windows® 10 is described as Windows 10.

Microsoft® Windows® 8.1 is described as Windows 8.1.

Microsoft® Windows® 8 is described as Windows 8.

Microsoft® Windows® 7 is described as Windows 7.

Windows® Internet Explorer® 11, Windows® Internet Explorer® 10, Windows® Internet Explorer® 9 and
Windows® Internet Explorer® 8 are described as Internet Explorer.

SDXC/SDHC/SD memory card is described as SD card or SD memory card.

Universal Plug and Play is described as UPnP™ or UPnP.

For administrator registration

At the time of first access to the camera (or at the time of initialization), the registration screen will be displayed.

Administrator registration

Enter the user name and password of the administrator.

Username (1 1o 32 characters) |
Password (810 32 characters) ]
Retype password ]

Mote:
{1) Distinguish between upper- and lower cases.
(2) Entry of the following is not allowed as a user name: 2-byte characters, and 1-byte symbols " & ;\
{3) Entry of the following is not allowed as a password: 2-byte characters, and 1-byte symbols " &
{4) For the password, use two or more types of characters from alphabetic characters, numbers, and symbols.
(5) Keep the user name and password at hand so as not to lose.
(6) It is recommended fo change the password periodically.

[User name (1 to 32 characters)]

Enter the user name of the administrator.
Available number of characters: 1 - 32 characters
Unavailable characters: 2-byte characters, and 1-byte symbols " & : ; \

[Password (8 to 32 characters)]/[Retype password]

Enter the administrator password.
Available number of characters: 8 - 32 characters
Unavailable characters: 2-byte characters, and 1-byte symbols " &

Note

* Distinguish between upper- and lower cases.
* For the password, use two or more types of characters from alphabetic characters, numbers, and
symbols.
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IMPORTANT

* If you forgot or do not know the password or user name, the camera must be initialized. Because all
settings other than preset position settings are deleted when the camera is initialized, make sure to
keep the information secure from third parties. Refer to “Parts and functions” section in the Important
Information in the supplied CD-ROM for more information about initializing the camera.

* |tis recommended to change the password periodically.

The registration completion screen will be displayed after registering a user name and password of the
administrator. After 10 seconds, the camera will be reconnected automatically. Please click “here” if it is not
displayed automatically.

When the camera is reconnected to, an authentication window is displayed. Enter the registered user name
and password to start operation.

Registration of administrator is completed.

After 10 seconds, the camera will be reconnected automatically .

Please click here if it is not displayed automatically.

Viewer software

In order to display H.265 (or H.264) images, send/receive audio to/from the camera, and play images saved
on the SD memory card, the “Network Camera View 4S” (ActiveX®) viewer software must be installed. This
software can be installed directly from the camera or by selecting the [Install] button next to [Viewer
Software] on the menu of the CD-ROM provided, and then following the on-screen instructions.

18] Metwork Camera View 45 - InstallShield Wizard =
License Agreement ‘
Flease read the following license agreement carefully, |*~'= _.
EMD USER LICEMSE AGREEMENT (ELILA) -

IMPORTAMT. Flease carefully read this End User License Agreement (ELLA}
before downloading this software program (the "Software™) provided by Panasconic
System Metworks Co., Ltd., a Japanese corporation. Before downloading,
installing and using the Software on your PC, you need to accept the terms and
conditions of this EULA by clicking on "I ACCEPT” button provided at the bottom of
this EULA. fyou do not agree to the terms and conditions of this EULA, you may
not download, install or use this software.

This ELLA is a legal agreement between you and Panasonic System MNetworks -

@) I accept the terms in the license agreement

71 I do not accept the terms in the license agreement

InstallShield

< Back ]I Mext = I [ Cancel
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IMPORTANT

The default setting of “Automatic installation” is “On”. Follow the instructions on page 236 when the
message is displayed on the information bar of the browser.

Depending on the software environment of your PC, it may take time for the message to be displayed
on the information bar of the browser.

If you display the “Live” page on a PC and click the [Viewer Software] button, the installation screen
for ActiveX, which is required for viewing camera images, is displayed. Follow the on-screen
instructions and install the software. When displayed JPEG images (still images), there is no need to
install ActiveX.

When the install wizard is displayed again even after completing the installation of the ActiveX, restart
the PC.

The viewer software used on each PC should be licensed individually. The number of installations of
the viewer software from the camera can be checked on the [Upgrade] tab of the “Maintenance” page
(—page 210). Refer to your dealer for the software licensing.
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1 Operations

1.1 Monitor images on a PC

The following are descriptions of how to monitor images from the camera on a PC.

1.1.1 Monitor images from a single camera

1. Start up the web browser.

2. Enter the IP address designated using the Panasonic “IP Setting Software” in the address box of the
browser.

* Example when entering an IPv4 address: http://URL registered using IPv4 address
http://192.168.0.10/

* Example when entering an IPv6 address: http://[URL registered using IPv6 address]
http://[2001:db8::10]/

<Example of IPv4 access>

(& Welcome to Tabbed Browsing - Windows Internet Explorer (== R =]

b bd I\ £] hitp'//192.168.010 -4 I-A W cive Searer D )
- ] - . e »

U @t | @ Welcome to Tabbed Browsing | | ":;’ * B ~ o= w7k Page ¥ (T} Tools »

<Example of IPv6 access>

& Welcome to Tabbed Browsing - Windows Internet Explorer =i

& I\g http://[2001:db8:10] 'I"' x | Live Search 2 -

: — — »
54 dhf | @8 Welcome to Tabbed Browsing oo B v ® v [k Page v (G Tools v

*  When the HTTP port number is changed from “80”, enter “http://IP address of the camera + : (colon)
+ port number” in the address box of the browser. (Example: http://192.168.0.11:8080)

* When the PC is in a local network, configure the proxy server setting of the web browser (under
[Internet Options...] under [Tools] of the menu bar) to bypass the proxy server for the local address.

* Refer to page 189 and page 194 for further information about the case in which “HTTPS” is
selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page (—page 156).
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3. Press the [Enter] key on the keyboard.
— The “Live” page will be displayed. Refer to page 13 for further information about the “Live” page.

Metwork Camera

—select language--

Live Setup et

Live view
| JPEG(1)

JPEG
Resolution: 1920x1080

Refresh interval

Refresh interval : 3s |

Zoom

_ Log/
Rec. on SD Play

RS$485 operation screen r X

Viewer software

When “On” is selected for “User auth.”, the authentication window will be displayed before displaying live
images for the user name and password entries.

IMPORTANT

* |tis recommended to change the password periodically.
*  When displaying multiple H.265 (or H.264) images on a PC, images may not be displayed depending
on the performance of the PC.

* The maximum number of concurrent access user is 14 including users who is receiving H.265 (or H.
264) images and users who are receiving JPEG images. Depending on the set values for “Bandwidth
control(bit rate)” and “Max bit rate (per client)*”, the maximum concurrent access number may be 14
or less users. When 14 users are concurrently accessing, the access limit message will be displayed
for users who subsequently attempt to access. When “Multicast” is selected for “Transmission type” of
“Stream”, only the first user who accessed to monitor H.265 (or H.264) images will be included in the
maximum number. The second and subsequent users who are monitoring H.265 (or H.264) images
will not be included in the maximum number.

e If you set the “Stream transmission” (—page 93) to “On”, an H.265 (or H.264) image will be displayed
based on the settings of the “Stream encoding format”. If you set the “Stream transmission” (—page
93) to “Off’, a JPEG image will be displayed. A JPEG image can be displayed even if the “Stream
transmission” is set to “On”, but in that case, the transmission interval of the JPEG image will be limited
to maximum 5 fps.

* The refresh interval may become longer depending on a network environment, PC performance,
photographic subject, access traffic, etc.
<Refresh interval of JPEG images>
When “On” is selected for “Stream transmission”
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max. 5fps
When “Off” is selected for “Stream transmission”
max. 30fps
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1.1.2 About the “Live” page

Note

* The buttons and setting items displayed on the “Live” page can be changed depending on the user
rights of the accessing user. You can set the user right settings from “User auth.” under “User mng.”.
(—page 151)

N.el\-.'ork Camera
L—selec.i Ian(:]uage——
Live Setup
Live view

{JPEG(1)
JPEG

Resolution: 1920x1080

Refresh interval F- ri
1 Refresh interval - 3s !
1

J- -
() & &
- Brightness
10~ Nomal @

AUX

Log/

Rec. on SD Play

RS5485 operation screen

Viewer software

@ [select language] pull-down-menu
The camera’s display language can be selected. The default language can be set in the [Menu language]
in the [Basic] settings. (—page 65)

@ [Login] button
This button is displayed when “User auth.” is “On” and a person other than the administrator logs in, or
when “User auth.” is “Off” and “Guest User” is set to “Use”. (—page 151)
Even in the above case, the [Login] button will not be displayed if “Host auth.” is set to “On”, and the camera
browser is opened from a host with administrator rights.

--select language--

Login

Live view
JPEG(1)

If login fails, close all the browsers, open the “Live” page and login once again.

[Setup] button™

Displays the setup menu.

[Live view] pull-down menu

You can select and switch to the image to be displayed in the main area from the following:
Stream(1)/Stream(2)/Stream(3)/Stream(4)/JPEG(1)/JPEG(2)/JPEG(3)/Multi-screen

® ©
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14

The image in the main area is displayed based on the contents set in Stream(1) — (4) (—page 93),
JPEG(1) — (3) (—page 91), or Multi-screen (—page 128).

Also the first stream displayed when you accessed the camera can be set from “Initial display stream” of
the [Image] tab. For “Multi-screen”, you can set the “Initial display” in the [Multi-screen] tab.

Note

*  When “2048x1536”, “1920x1080”, “1280x960” or “1280x720” is selected for the image capture
size, it may become smaller than the actual size depending on the window size of the web browser.
Stream information display
Displays the setup for stream encoding format, image capture size, bit rate, and frame rate for the live view
of a stream.

Note

* Displays the values set in the stream. The actual bit rate and frame rate vary depending on the
network environment and the used PC.

[Refresh interval] pull-down menu

This pull-down menu will be displayed only when a JPEG image is displayed. Use it to select the display

method of the JPEG image.

* MJPEG: Uses viewer software to display JPEG images successively as MJUPEG (Motion JPEG). Not
available if the viewer software is not installed.

* Refresh interval : 1s/Refresh interval : 3s/Refresh interval : 5s/Refresh interval : 10s/Refresh
interval : 30s/Refresh interval : 60s: Refreshes JPEG format (still images) images at the specified
interval.

Note

* Depending on the network environment or the PC used, JPEG format (still images) images may
not be refreshed at the specified interval.
[Zoom] buttons
Images will be zoomed in on with the electronic zoom by the viewer software “Network Camera View
48’
* [x1] button: The images in the main area will be displayed at x1.
* [x2] button: The images in the main area will be displayed at x2.
* [x4] button: The images in the main area will be displayed at x4.
[Brightness] buttons™
The brightness is adjustable from 0 to 255. Click the ﬂ button to make the image brighter, or click the

E button to make the image darker. If you click the [Normal] button, the display will be reset to default.

[AUX] button 7K 522x1 X S21x1 4

These buttons will be displayed only when “Terminal 3” of “Alarm” is set to “AUX output” on the setup menu.
(—page 51)

* [Open] button: The status of the AUX connector will be open.

* [Close] button: The status of the AUX connector will be closed.

Note

(LI

* The names of “AUX”, “Open” and “Close” can be changed. (—page 133)

[Rec. on SD] button™ CFETRY S22x1 L S21x1

The [Rec. on SD] button will be displayed only when “Manual” is selected for “Save trigger” on the [SD
memory card] tab. (—page 75)

Click this button to manually record images on the SD memory card. Refer to page 26 for descriptions
of how to manually record images on the SD memory card.
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[Log] button PR S22x1 QL S21x1

When the [Log] button is clicked, the log list will be displayed and images saved on the SD memory card
can be played.

Refer to page 32 for further information about the log list and for how to play images on the SD memory
card.

RS485(pan/tilt head)

This button is available only when the [RS485 operation screen] in the [RS485] tab is set to “On(pan/tilt

head)”. (—page 208) If you click the button, the screen to control the pan/tilt head will be displayed.

Auto mode Brightness

Normal

Home position

IMPORTANT

* Depending on the pant/tilt head connected to, some functions may not be available. Refer to the
specifications of your pan/tilt head for more information. Refer to the operating instructions of the
pan/tilt head for further information about its operation.

[Viewer Software] button

Starts installation of the viewer software for display. This button will not be available if the viewer software
is already installed on the PC, or if the “Automatic installation” of the [Viewer software
(nwecv4Ssetup.exe)] in the [Basic] tab is set to “Off”. (—page 70)

Camera title

The camera title entered for “Camera title” on the [Basic] tab will be displayed. (—page 66)

Support button

When this button is clicked, the support site below will be displayed in a newly opened window. This website
contains technical information, FAQ, and other information.

https://security.panasonic.com/support/

Alarm occurrence indication button™

When an alarm occurs, the display flashes. When this button is clicked, the output terminal will be reset
and this button will disappear. (—page 28)

Note

» Since the blinking of the alarm occurrence indication button is not coupled to recording images to
the SD memory card, forwarding E-mails, or other operations, check the settings of each operation
separately.

Full screen button

Images will be displayed on a full screen. If the full screen button is clicked once when the image displayed
in the main area is smaller than the main area, the image is displayed corresponding to its image capture
size. If the full screen button is clicked once when images are displayed corresponding to their image
capture sizes, images are displayed in full screen. To return to the “Live” page when displaying an image
in full screen, press the [Esc] key.

Snap shot button

Click this button to take a picture (a still picture). The picture will be displayed on a newly opened window.
When right-clicking on the displayed image, the pop-up menu will be displayed. It is possible to save the
image on the PC by selecting “Save” from the displayed pop-up menu.

When “Print” is selected, printer output is enabled.
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* The following settings may be required.
Open Internet Explorer, click [Tools] — [Internet Options] — [Security] — [Trusted Sites] —
[Sites]. Register the camera address on [Website] of the displayed trusted windows. After
registration, close the web browser, and then access the camera again.

*  When it takes longer than the specified period to obtain the snap shot picture due to the network
environment, the snap shot picture may not be displayed.

* Ifthe image capture size specified for JPEG cannot be obtained, JPEG images are displayed with
the image capture size that could be obtained.
Therefore, when JPEG images obtained with snap shot are displayed on a PC, the displayed image
size may differ from the captured sized.

Mic input button 715X 522x1 X S21x1 X S21x0 J
Turns on/off the audio reception (hear audio from the camera on a PC). This button will be displayed only
when “Mic input”, “Interactive(Full-duplex)”, or “Interactive(Half-duplex)” is selected for “Audio transmission
mode” on the setup menu. (—page 124)

When the audio reception is turned off, the button will turn into the . button and audio from the camera

will not be heard.
Audio volume can be adjusted (Low/ Middle/ High) by moving the volume cursor ..

Note

*  When “Audio volume control mode” is set to “Adjust Mic input” in the setup menu, the volume cursor
is not displayed when using “Audio recording” or “Audio detection”.

* When the camera is restarted, the adjusted volume level (for the reception) will return to the level
that had been set on the [Audio] tab on the setup menu. (—page 124)

* Actual volume level will change in three steps even though the volume cursor can be adjusted
minutely.

* If multiple camera browsers are open at the same time on the same computer, audio cannot be
heard from the camera browsers that were opened later. Please only access 1 camera at a time.

@ Audio output button TR S22x1 X S21x1 4

Turns on/off the audio transmission (play audio from the PC on the unit speaker). This button will be
displayed only when “Audio output”, “Interactive(Full-duplex)” or “Interactive(Half-duplex)” is selected for
“Audio transmission mode” on the setup menu. (—page 124)

The button will blink during the audio transmission. When the audio transmission is turned off, the button

display will switch to the - and audio from the PC will not be heard.
Audio output volume can be adjusted (Low/Middle/High) by moving the volume cursor [

Note

* When a user is using the audio transmission function with “Interactive(Half-duplex)” selected, the
receiver button and the transmission button will be inoperable for the other users. When
“Interactive(Full-duplex)” is selected, the transmission button is inoperable for other users.

* The maximum duration of a single audio output is the audio output duration set in the [Audio] tab
on the “Image/Audio” page. Audio output stops when the specified audio output duration has
passed. To turn the audio transmission function on, click the [Audio output] button again.

*  When the camera is restarted, the adjusted volume level (for both the audio transmission and
reception) will return to the level that had been set on the [Audio] tab on the “Image/Audio” page.
(—page 124)

* Actual volume level will change in three steps even though the volume cursor can be adjusted
minutely.

@ SD recording status indicator &VITPX S22x1 X S521x1

The status of the SD recording can be checked with this indicator.
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When the SD recording starts, the SD recording status indicator will light red. It will go off when the SD
recording stops.

This indicator will be displayed when “Manual” or “Schedule” is selected for “Save trigger” on the setup
menu. (—page 72)

Main area

Images from the camera will be displayed in this area.

The current time and date will be displayed according to the settings configured for “Time display format”
and “Date/time display format”. (—page 65)

In addition, when being adjusted, the status of brightness (—page 68) will be displayed as well as the
characters configured for “Camera title on screen” (—page 67).

A zoom operation can be performed using the mouse wheel.

When clicking a desired point while displaying live images at x2 or x4 in the main area, the camera will
move to locate the clicked point at the center of the main area.

Note

* When the camera is operated by a user with a low access level, images displayed on the screen
may be changed temporarily. This does not affect operation of the camera.

* Depending on the PC in use, screen tearing® may occur when the shooting scene drastically
changes due to the GDI restrictions of the OS.
*A phenomenon in which portions of the screen are displayed out of alignment.

Only operable by users whose access level is “1. Administrator”.
Only operable by users whose access level is “1. Administrator” or “2. Camera control” when “On” is selected for “User
auth.” (—»page 151)
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1.1.3 Monitor images from multiple cameras

Images from multiple cameras can be displayed on a multi-screen. Images from 4, 9, and up to 16 cameras
can be displayed simultaneously. To display images on a multi-screen, it is necessary to register cameras in
advance. 4 cameras can be registered as a group and up to 4 groups (16 cameras) can be registered.
(—page 128)

18

IMPORTANT

When video is displayed in 4 screens and 9 screens, the video and audio may cut out because the
transmission volume of other cameras is large. In such cases, the setting of the registered cameras
needs to be changed to reduce the transmission volume.

Example of setup to reduce the transmission volume:

— Set the video transmission format to “H.265” or “H.264”.

— Set the “Transmission priority” (—page 95) of the stream to “Best effort”.

To enable the audio for multi-screen, the audio must be enabled for the camera.

When 16 screens are used for the display, only still images (JPEG) can be refreshed.

Multi-screen can be used to display JPEG images, and H.265 (or H.264) images. If other cameras
support audio, audio is also output.

For further information about “Network Camera Recorder with Viewer Software Lite”, which is suited
to viewing images from several cameras, refer to our website
(https://security.panasonic.com/support/info/).

When you have registered a camera with the authentication function enabled, enter the user name and
password of the “Administrator” for the registered camera in the “Authentication dialog”.

Refer to the Panasonic support website below for information about the terms and conditions for use
of multi-screen.

https://security.panasonic.com/support/info/
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1. From the “Live view” pull-down menu in the “Live” page, select “Multi-screen”.
— Images from the registered cameras will be displayed on a selected multi-screen (screen can be split
up to 16 areas). The following are instructions when displaying on a 4-split screen.

Network Camera

Live Setup

Live view
| Multi-screen

Layout

Refresh interval
{ MIPEG B

Image capture size
{ 320x180

@ “Live view” pull-down menu
Select the image displayed in the main area.

@ [Layout] pull-down menu
Select from the pull-down menu to display images from cameras in multi-screens of 4 to 9 or even 16
screens.

® [Refresh interval] pull-down menu
Select from the pull-down menu and switch between video (H.265/H.264/MJPEG) and still images
(JPEG).
For still images (JPEG), select the refresh interval (Refresh interval : 1s/Refresh interval : 3s/Refresh
interval : 5s/Refresh interval : 10s/Refresh interval : 30s/Refresh interval : 60s) for camera images.
When the 16 screen layout is used, Refresh interval : 1s cannot be selected.

@ [Image capture size] pull-down menu
Select the image capture size from the pull-down menu to change it.
When you select “4 Screens” in the [Layout] pull-down menu, the image capture size of the camera
changes.
*  When the aspect ratio is 4:3:

Switching between QVGA (default) and VGA
*  When the aspect ratio is 16:9:
Switching between 320x180 (default) and 640x360

® Full screen display
If you press the full screen button, the display of the camera image will be maximized. If you click the
(reset) button in the full screen display, the display size will be reset to original size.

(® Camera title
If you click the camera title, live images from the corresponding camera will be displayed on the
“Live” page of the newly opened window.

@ Camera control bar
Can be used to get snap shot of JPEG images or to adjust the PC mic input/output volume (mic input
or audio output).
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* The frame rate may drop depending on the network environment and number of accessing users.

* |f the image capture size specified for JPEG cannot be obtained, a JPEG image with an image
capture size that could be obtained is displayed. Therefore, when JPEG images obtained with snap
shot are displayed on a PC, the displayed image size may differ from the captured sized.
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1.2 Monitor images on a cellular phone/mobile
terminal

1.2.1 Monitor images on a cellular phone

It is possible to connect to the camera using a cellular phone via the Internet and monitor images (JPEG only)
from the camera on the screen of the cellular phone. It is also possible to refresh images to display the latest

image.

IMPORTANT

When the authentication window is displayed, enter the user name and password.

To enhance the security, it is recommended to change the password periodically. (—page 151)

If the cellular phone in use is not compatible with UTF-8 encode, it is impossible to display the screen
correctly.

When “VGA”, “QVGA”, “640x360”, or “320x180” is not selected for either one of “UPEG(1)",
“JPEG(2)", or “JPEG(3)” of [JPEG] on the [Image] tab, images cannot be viewed from cellular phones.
Audio is not supported for cellular phones.

It is necessary to configure the network settings of the cellular phone in advance to connect to the
Internet and monitor images from the camera. (—page 156)

When “Auto” is selected for “Menu language”, the screen is displayed in English. If you want the screen
to be displayed in Japanese or Chinese, select “Japanese” or “Chinese” for “Menu language”.
(—page 65)

For further information about compatible devices, refer to our website
(https://security.panasonic.com/support/info/).

1. Access to “http://IP address/mobile™ or “http://Host name registered in the DDNS server/mobile” using a
cellular phone.
— Images from the camera will be displayed.

(5)Manual Refresh Auto Refresh |-

O]
(O)Resolution | ®
AUX
"O‘pE'nll “Clﬂse” @
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@ Refresh control

Press the dial key “5” or the [Manual Refresh] button to refresh the camera images.

Press the [Auto Refresh] button to refresh the images from the camera in 5-second intervals.

When the dial key “5” or the [Manual Refresh] button is pressed again, the refresh mode of the camera
will return to manual refresh.

IMPORTANT

* Transmission will be periodically performed when “Auto Refresh” is selected for the camera
image. Confirm the contract plan of the cellular phone in use before using this function.
* Depending on the cellular phone in use, “Auto Refresh” may be unavailable.

Resolution control

Changes the image capture size by pressing the dial key “0”.

* Image in the aspect ratio of “4:3”; Changes the image capture size between 320x240 (default) and
640x480.

* Image in the aspect ratio of “16:9”: Changes the image capture size between 320x180 (default)
and 640x360.

AUX control

Controls the AUX terminal. These buttons will be displayed only when “AUX output” is selected for

“Terminal 3” on the setup menu. (—page 51)

Some cellular phones cannot change the image capture size even when resolution is changed by
resolution control.

Depending on the image capture size selected for “UPEG(1)”, “JPEG(2)”, or “JPEG(3)”, “Resolution”
may not be able to be used.

When the HTTP port number is changed from “80”, enter “http://IP address: (colon) + port number/
mobile”" in the address box of the browser. When using the DDNS function, access to “http://Host
name registered in the DDNS server: (colon) + port number/mobile”.

When “HTTPS” is selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page,
enter as follows.

“https://IP address: (colon) + port number/mobile” or “https://Host name registered in the DDNS server:
(colon) + port number/mobile”

When the authentication window is displayed, enter the user name of an administrator or user and
password. Depending on the cellular phone in use, password entry may be required each time the
screen is switched.

Depending on the cellular phone in use, larger size images may not be displayed. In this case, selecting
a setting close to the lowest quality setting for “Image quality setting” of “JPEG” (—page 91) may
sometimes solve this problem.

Depending on the cellular phone in use or its contract plan, it may be impossible to access.

The operations menu displayed on the mobile telephone screen may not be displayed depending on
the user rights and access level of the accessing user. To display the operations menu, it is necessary
to set the user rights and access level (“User auth.” in “User mng.”). (—page 151)

" |P address is the global WAN IP address of the router that can be accessed via the Internet.

1.2.2 Monitor images on a mobile terminal (including
smartphones)

It is possible to connect to the camera using a mobile terminal via the Internet and monitor images (MJPEG
or JPEG) from the camera on the screen of the mobile terminal. It is also possible to refresh images to display
the latest image.
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The compatible mobile terminals are shown as follows. (As of August, 2016)

— iPad, iPhone (iOS 4.2.1 or later)

— Android™ mobile terminals

When an Android terminal is used, an MJPEG format image is displayed by the Firefox® browser, and a JPEG
format image is displayed by the standard browser.

For further information about compatible devices, refer to our website
(https://security.panasonic.com/support/info/).

IMPORTANT

* When the authentication window is displayed, enter the user name and password.
To enhance the security, it is recommended to change the password periodically. (—page 151)

Note

* ltis necessary to configure the network settings of the mobile terminal in advance to connect to the
Internet and monitor images from the camera. (—page 156)

1. Access to “http://IP address/cam™ or “http://Host name registered in the DDNS server/cam”™ using a
mobile terminal.
— Images from the camera will be displayed.

@ Live images area
Displays images from the camera.

(@ Operation buttons area
When functions are selected in the function selection area (3), buttons to operate those functions are
displayed.

® Function selection area
When functions that can be operated are selected, operation buttons are displayed in the operation
buttons area 2.

Note

* The operations button displayed on the mobile terminal screen may not be available depending on
the user rights and access level of the accessing user. To display the operations button, it is
necessary to set the user rights and access level (“User auth.” in “User mng.”). (—page 151)
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2. Click the button of the function that you want to operate.

(@ Resolution control
@ AUX control

Each function is explained below.
@ Resolution control
Press this button to display the buttons used to select the resolution on the screen.
The resolution can be changed by selecting a resolution setting from the buttons.
Images are displayed in the image capture size selected in “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” of
[JPEG] on the [Image] tab.
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® AUX control

Press the E button to display the buttons used to operate the AUX output on the screen.

The AUX output terminals can be controlled with the and buttons.

This function is only displayed when [Terminal 3] is set to [AUX output] on the settings menu.
(—page 51)

You can change the image size displayed on the mobile terminal by accessing the following addresses.
— Large display: http://IP address/cam/dI

— Medium display: http://IP address/cam/dm

— Small display: http://IP address/cam/ds

When the resolution is changed by the resolution control, the displayed resolution changes but the
image size remains the same.

When the HTTP port number is changed from “80”, enter “http:/IP address: (colon) + port number/
cam”” in the address box of the browser. When using the DDNS function, access to “http://Host name
registered in the DDNS server: (colon) + port number/cam”™2,

When “HTTPS” is selected for “HTTPS” - “Connection” on the [Advanced] tab of the “Network” page,
enter as follows.

“https://IP address: (colon) + port number/cam” or “https://Host name registered in the DDNS server:
(colon) + port number/cam”

When the authentication window is displayed, enter the user name of an administrator or user and
password. Depending on the mobile terminal in use, password entry may be required each time the
screen is switched.

It is impossible to send and receive audio using a mobile terminal.

Depending on the mobile terminal in use, larger size images may not be displayed. In this case,
selecting a setting close to the lowest quality setting for “Image quality setting” of “JPEG” (—page
91) may sometimes solve this problem.

Depending on the mobile terminal in use or its contract plan, it may be impossible to access.

" IP address is the global WAN IP address of the router that can be accessed via the Internet. However, when accessing the same
LAN as the camera with a wireless compatible mobile terminal, the IP address is the local IP address.
2. Only when accessing the camera via the Internet.
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1.3 Record images on the SD memory card manually
L 522:1 R S21x12

Images displayed on the “Live” page can be recorded on the SD memory card manually. This button is operable
only when “Manual” is selected for “Save trigger” on the [SD memory card] tab on the “Basic” page of the setup
menu. (—page 75)

It is possible to select “JPEG(1)”, “JPEG(2)", “JPEG(3)”, “Stream(1)”, “Stream(2)”, “Stream(3)”, or
“Stream(4)” on “Recording format” of the setup menu. (—page 74) When “JPEG” is selected for “Recording
format”, still image data are recorded. When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected,
video data are recorded.

Images recorded on the SD memory card can be copied onto the PC. (—page 86)

1. Display the “Live” page. (—page 10)

2. Click the [Rec. on SD] button.
— The SD recording window will open.

Record on the SD memory card

Start Stop

3. Click the [Start] button to start recording images on the SD memory card. The SD recording status indicator
will light red (—page 13) while images are being recorded on the SD memory card.
The image saving interval can be configured on the [SD memory card] tab of the “Basic” page.
(—page 72)
4. Click the [Stop] button to stop saving images on the SD memory card.
— The SD recording status indicator will turn off.
5. Click the [Close] button to close the window.
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Image data saved on Drive B can be obtained by executing “Access img.” on the [SD memory card]
tab and logging in from the user authentication window (—page 86).

The destination to save image data is a fixed directory on Drive B (—page 238).

When the [Start] button is clicked immediately after the [Stop] button is clicked, saving of images may

not start. In this case, click the [Start] button again.
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1.4 Action at an alarm occurrence

The alarm action (camera action at an alarm occurrence) will be performed when the following alarms occur.

1.4.1 Alarm type

* Terminal alarm: When connecting an alarm device such as a sensor to the alarm input terminal of the
camera, the alarm action will be performed when the connected alarm device is activated.

* VMD alarm: When motion is detected in the set VMD area, the alarm action will be performed.
*VMD stands for “Video Motion Detection”.

* Audio detection alarm: When the configured audio detection level is exceeded, the alarm action will be
performed.

* Command alarm: When a Panasonic alarm protocol is received from the connected device via a network,
the alarm action will be performed.

1.4.2 Action at an alarm occurrence
Display the alarm occurrence indication button on the “Live” page

The alarm occurrence indication button will be displayed on the “Live” page at an alarm occurrence.
(—page 13)

IMPORTANT

*  When “Polling(30s)” is selected for “Status update mode” (—page 65), the Alarm occurrence
indication button will be refreshed in 30-second intervals. For this reason, it may take a maximum of
30 seconds until the alarm occurrence indication button is displayed on the “Live” page at an alarm
occurrence.

Notify of alarm occurrences to the device connected to the output terminal
7SR S22x1 K S21x1J

It is possible to output signals from the output terminal of the camera and sound the buzzer when an alarm
occurs. The settings for the alarm output can be configured in the [Alarm] tab of the “Alarm” page.
(—page 132)

Save images on the SD memory card L S22x1 2
L S21x1 2

When an alarm occurs, images (JPEG/H.265/H.264) will be saved on the SD memory card. The settings to
save images on the SD memory card can be configured on the [SD memory card] tab (—page 72) of the
“Basic” page and the [Alarm] tab of the “Alarm” page. (—page 134)

Transmit an image onto a server automatically

An alarm image can be transmitted at an alarm occurrence to the server designated in advance. The settings
required to transmit an alarm image to a server can be configured in the “Alarm image” section on the
[Alarm] tab of the “Alarm” page (—page 134) and the [Advanced] tab of the “Network” page (—page 166).
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Notify of alarm occurrences by E-mail

Alarm E-mail (alarm occurrence notification) can be sent at an alarm occurrence to the E-mail addresses
registered in advance. Up to 4 addresses can be registered as recipients of the alarm E-mail. An alarm image
(still picture) can be sent with the alarm E-mail as an attached file. The settings for alarm E-mail can be
configured in the “Alarm E-mail notification” section on the [Alarm] tab of the “Alarm” page (—page 134) and
the [Advanced] tab of the “Network” page (—page 161).

Notify of alarm occurrences to the designated addresses (Panasonic alarm
protocol notification)

This function is available only when a Panasonic device, such as the network disk recorder, is connected to
the system. When “On” is selected for “Panasonic alarm protocol”, the connected Panasonic device will be

notified that the camera is in the alarm state. The settings for Panasonic alarm protocol can be configured in
the “Panasonic alarm protocol notification” section of the [Notification] tab of the “Alarm” page. (—page 147)

Notify of alarm occurrences to the designated HTTP server (HTTP alarm
notification)

Alarm occurrence notifications can be sent at an alarm occurrence to the HTTP servers registered in advance.
Up to 5 HTTP servers can be registered as recipients of alarm notifications. The URL sent to HTTP servers
with alarm notifications can be specified. The settings for HTTP alarm notification can be configured on the
[Notification] tab of the “Alarm” page. (—page 149)
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1

.5 Transmit images onto an FTP server

Images can be transmitted to an FTP server. By configuring the following settings, transmission of images
captured at an alarm occurrence or captured at a designated interval to an FTP server will become available.

IMPORTANT

* When using this function, set the user name and the password to access the FTP server to restrict
users who can log into the FTP server.

1.5.1 Transmit an alarm image at an alarm occurrence (Alarm
image transmission)

An alarm image can be transmitted at an alarm occurrence to the FTP server. To transmit alarm images to an
FTP server, it is necessary to configure the settings in advance.

FTP server settings and settings relating to alarm image transmission can be configured in the “FTP” section
of the [Advanced] tab of the “Network” page. (—page 166) Settings can also be configured from the “Alarm
image FTP transmission” settings of “Camera action on alarm” on the [Alarm] tab of the “Alarm” page.
(—page 134)

Note

* Depending on the network traffic, the number of the transmitted images may not reach the set number
of images to be transmitted.

* Alarm images failed to be transmitted to the FTP server at an alarm occurrence will not be saved on
the SD memory card. However, images that fail to be transmitted with the FTP periodic image
transmission will be saved.

When “On” is selected for both the alarm image transmission function and the FTP periodic image
transmission function, the alarm image transmission function will be given priority over the FTP periodic
image transmission function. Also, when “On” is selected for the “FTP transmission retry” FTP setting
(—page 167), alarm images will be retransmitted if there is an FTP transmission failure. Therefore, if
there is continuous retransmission due to network problems or other factors, periodic transmission will
not be performed and images that fail to be transmitted with the FTP periodic image transmission will
not be saved to an SD memory card.

1.5.2 Transmit images at a designated interval or period (FTP
periodic image transmission)

30

Images can be transmitted at a designated interval or period. To transmit images at a designated interval or
period, it is necessary to configure the settings in advance.

FTP server settings and settings relating to FTP periodic transmission image transmission can be configured
in the “FTP” section of the [Advanced] tab of the “Network” page. (—page 166)

Configure the schedule settings of the FTP periodic image transmission on the “Schedule” page.

(—page 204)

Note

* Depending on the line speed or the traffic, images may not be transmitted at the designated interval.

* When “On” is selected for both the alarm image transmission function and the FTP periodic image
transmission function, the alarm image transmission function will be given priority over the FTP periodic
image transmission function. Therefore, images may not be transmitted at the interval designated on
the “FTP periodic image transmission” setting.
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1.5.3 Save images on the SD memory card when images fail to
transmit using the FTP periodic image transmission function
75X S22x1 X S21x1 4

Images that have failed to transmit using the FTP periodic image transmission can be saved automatically on
the SD memory card. It is possible to select a trigger to save images on the SD memory card on the [SD
memory card] tab of the “Basic” page. (—page 72)

To use the SD memory backup function featured in Panasonic network disk recorder, select “Off” for “FTP
periodic image transmission” (—page 168) and “FTP periodic image transmission error” for “Save trigger” of
“Recording stream 1” (—page 75).

Note

* When “On” is selected for both the alarm image transmission function and the FTP periodic image
transmission function, the alarm image transmission function will be given priority over the FTP periodic
image transmission function. Also, when “On” is selected for the “FTP transmission retry” FTP setting
(—page 166), alarm images will be retransmitted if there is an FTP transmission failure. Therefore, if
there is continuous retransmission due to network problems or other factors, periodic transmission will
not be performed and images that fail to be transmitted with the FTP periodic image transmission will
not be saved to an SD memory card.

IMPORTANT

* We make no guarantee for any damages of files on the SD memory card incurred by malfunction or
error occurrence in files saved in the SD memory card regardless of what the cause may be.
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1.6 Display the log list L 522x1 R s21x1 4

The history of various logs will be displayed in list form.

* Alarm log: Logs of the alarm occurrences such as time and date of the alarm occurrences, the image
recording period and the alarm type will be displayed.

* Manual/Schedule log: Logs filed when images have been recorded manually or during the period of the
schedule, and the image recording period will be displayed.

* FTP trans. error log: Logs filed when the FTP periodic image transmission function has failed will be
displayed.

1. Display the “Live” page.

RS485 operation screen
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2. Click the [Log] button.
— The log list will be displayed in a newly opened window (log list window).

Time Sep/05/2016 18:11:33 - Sep/08/2016 02:55:18
Recording stream
QO stream 1 ® Stream 2
Event
O an ® Select
M Alarm log
M Manual/Schedule log
M FTP frans. error log
Recording time

rom [ First recorcin 2

YO IMMDD HH:MM:SS

To Lastrecorin 2

MM/DD HH:M
Search

K >

Time & date Duration
Sep/08/2016 02:55:13
Sep/06/2016 02:00:00
S5ep/06/2016 01:33:38
Sep/05/2016 23:00:00
Sep/05/2016 22:00:00
Sep/05/2016 21:00:00
Sep/05/2016 20:22:54
Sep/05/2016 20:00:00

Sep/05/2016 19:00:00
Sep/05/2016 18:11:33

5D memory card
3064MB/7560MB(rem.forg.)

IMPORTANT

* Only a single user can operate the log list window. Other users cannot access the log list window.

@® Time

Displays the time period of the data recorded on the SD memory card.
@ Recording stream

Select the recording stream that you want to display logs for.

Stream 1: The logs recorded by “Recording stream 1” on the [SD memory card] tab will be displayed.
Stream 2: The logs recorded by “Recording stream 2” on the [SD memory card] tab will be displayed.

® Event
Select a log type to display on the log list.

All: All logs will be displayed.

Select: Only the logs of the selected log type will be displayed.

— Alarm log: The log when an alarm is detected will be displayed.

— Manual/Schedule log: Manual and Schedule logs will be displayed.

— FTP trans. error log: Logs filed when the FTP periodic image transmission function has failed will
be displayed.

Default: All
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*  When “Stream 17 is selected for “Recording stream” and either “JPEG(1)”, “JPEG(2)”, or
“JPEG(3)” is selected for “Stream 17, the FTP trans. error log will be displayed.
@ Recording time
Configure the time period of logs displayed on the log list.
* From: Configure the starting period of logs displayed on the log list.
— First recording: Displays from the first log recorded on the SD memory card.
— Today: Displays the logs recorded today.
— Yesterday: Displays the logs recorded from yesterday to the present day.
— Last 7 days: Displays the logs recorded from 6 days ago to the present day.
— Last 30 days: Displays the logs recorded from 29 days ago to the present day.
— Date/time: Displays the logs recorded from the entered date and time on “Date/time” box.
* To: Configure the ending period of logs displayed on the log list when “First recording” or “Date/time”
is selected for “From”.
— Last recording: Displays until the last log recorded on the SD memory card.
— Date/time: Displays the logs recorded until the entered date and time on “Date/time” box.
® [Search] button
Searches for logs according to the conditions specified in “Event” and “Recording time”.
The search result will be displayed on the log list.
® Log list
Displays the log search results.
You can play back recorded data by clicking on the time or duration of the recorded data displayed under
[Time & date] and [Duration].

. (Top) button: Click this button to display the log listed at the top.

. (Prev. page) button: Click this button to display the previous page of the log list.
. (Next page) button: Click this button to display the next page of the log list.

. (Last) button: Click this button to display the log listed at the bottom.

* [Time & date]: Time and date when each log has been recorded will be displayed.

Note

*  When “Off” is selected for “Time display format”, the alarm occurrence times are displayed in

24 hour time format.

* The recording timing of logs is as follows.

— Alarm log: Alarm occurrence time and date will be filed as a log.

— Manual/Schedule log: Time and date when recording of images onto the SD memory card
started manually or during the period of the schedule will be filed as a log. When images
are recorded sequentially, if “JPEG” is selected for “Recording format”, logs will be filed on
the hour every hour (12:00, 1:00, 2:00, etc.). If “Stream” is selected for “Recording
format”, logs will be filed every hour from the time when recording starts.

— FTP trans. error log: Logs will be filed every one hour.

* [Duration]: Displays the period of time that the data has been recorded on the SD memory card.

Note

* The difference between the recording end time and recording start time of the image is
calculated by rounding off to the nearest tenth of a second. For this reason, when only 1 JPEG
image is saved, 00:00:00 is displayed for the duration.

* [Event]: The event type will be displayed.
— MN/SC: Log by “Manual/Schedule”
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— TRM1: Alarm by alarm input to Terminal 1

— TRM2: Alarm by alarm input to Terminal 2

— TRM3: Alarm by alarm input to Terminal 3

— VMD: Alarm by VMD alarm

— COM: Alarm by command alarm

— AUD: Alarm by audio detection alarm

— FTP: Logs saved from FTP periodic image transmission errors

[SD memory card]: Available capacity and the original capacity of the SD memory card will be
displayed.

. (Delete) button: Deletes log lists from all pages. When logs are searched for, only the searched

logs are deleted. Images associated with deleted logs will also be deleted.

IMPORTANT

If there are many recorded data files on the SD memory card, it may take time to delete all of
them. (For example, when the total size is 1 GB, it may take about 1 hour to delete the files.)

In this case, format the SD memory card. However, please note that formatting will delete all

of the files on the SD memory card.

In the process of the deletion, “Alarm” and “Manual/Schedule” cannot be operated.

Do not turn off the power of the camera until the deletion is complete. When the power of the
camera is turned off in the process of the deletion, some images may remain on the SD memory

card. In this case, click the button on the same log list window used to delete the logs.

(Download) button: Click this button to download all logs of the selected log list onto the PC.

Note

The following settings may be required.

Open Internet Explorer, click [Tools] — [Internet Options] — [Security] — [Trusted Sites] —
[Sites]. Register the camera address on [Website] of the displayed trusted windows.

After registration, close the web browser, and then access the camera again.

Up to 50,000 logs will be downloaded to the SD memory card. When more than 50,000 logs
are filed, the older logs will be overwritten by the newer logs. In this case, the oldest log is the
first to be overwritten.

If there are many logs, it may take time to download the logs.

(Close) button: Click this button to close the log list window.
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1.7 Playback of images on the SD memory card
L 5221 R S21x1 4

When clicking a time and date listed on the log list window, the “Live” page will turn to the “Playback” page.
When images associated with the clicked time and date are on the SD memory card, the first image of them
will be displayed.

The display format varies depending on the “Recording format” of the SD memory card.

IMPORTANT

Refresh interval of images may become slow during playback or download.

When many images are saved on the SD memory card, it may take time to display images on the
“Playback” page.

When the aspect ratio is “4:3”, images will be displayed in VGA size on the “Playback” page regardless
of the image capture size of the images saved on the SD memory card. When the aspect ratio is
“16:9”, images will be displayed in “640x360” on the “Playback” page regardless of the image capture
size of the images saved on the SD memory card. Therefore, images may look coarse on the
“Playback” page.

When playing images by selecting an FTP error log on the log list, images may not be played in order
of images recorded on the SD memory card if they have been recorded on the SD memory card with
selected value for the “Transmission interval” setting of “FTP periodic image transmission” on the
[Advanced] tab is “I/min” or less.

The playback refresh interval may become slower when recording data to the SD memory card.

1.7.1 Playback “JPEG(1)”/“JPEG(2)”/“JPEG(3)” images saved to
the SD memory card

36

@® Number of images
When clicking a time and date listed on the log list window, total number of images associated with the
clicked time and date, and the number of the currently displayed image will be displayed.
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* Enter the desired number of image and press the [Enter] key on the keyboard. The image of the
designated number will be displayed.

EX] (REW) button

Each time the button is clicked, the playback speed will change.
When the . button or the . button is clicked during fast reverse playback, playback speed will return to
the normal playback speed.

Kl (REV PLAY) button

Images will be played in reverse sequential order.

I3 (PLAY) button

When this button is clicked, images will be played in sequential order.

23 (FF) button

Each time the button is clicked, the playback speed will change.
When the . button or the . button is clicked during fast playback, playback speed will return to the normal
playback speed.

Kl (toP) button
The first image will be displayed.

Kl (PREV. IMAGE) button

The previous frame will be displayed and paused when this button is clicked during playback.
Each time this button is clicked during pausing, the frame previous to the currently displayed frame will be
displayed.

Note

*  When the mouse button is held down while the mouse pointer is on this button, the image number will
be decreased.
When the mouse button is released, the decreasing of the image number will stop and the image
corresponding to the currently displayed number will be displayed.

I} (PAUSE) button

Playback will be paused when this button is clicked during playback.
Playback will resume when this button is clicked during pausing.

] (sToP) button

Playback will stop and the “Playback” window will turn to the “Live” page.

I (NEXT IMAGE) button

The next frame will be displayed and paused when this button is clicked during playback.
Each time this button is clicked during pausing, the frame next to the currently displayed frame will be displayed.
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* When the mouse button is held down while the mouse pointer is on this button, the image number will
be increased.
When the mouse button is released, the increment of the image number will stop and the image number
displayed at the moment when the mouse button is released will be displayed.

Bl (LAST) button

The last image will be displayed.

(Start) button

The selected image will be downloaded onto the PC. Before downloading images, designate the destination
directory in advance. (—page 88)

The following window will be displayed when the button is clicked.

Select the image to be downloaded, and then click the [OK] button.

o Al
® Current image

® Download range - - -

Destination directory for download
C:Anwcam

Cancel

* All: Allimages saved at the selected time and date will be downloaded.
* Current image: Only the currently displayed image will be downloaded.
* Download range: Images in the specified range will be downloaded.

Note

* When the [Cancel] button is clicked in the process of the download, the download will be canceled. In
this case, images already downloaded before clicking the [Cancel] button will be saved on the PC.

E (Browse) button

When successfully logged in after the user authentication process, a folder on the SD memory card in which
images are saved will be displayed. (—page 86)

Note

* FTP access to camera must be allowed.
Select “Allow” for “FTP access to camera” on the [Network] tab.
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1.7.2 Playback “Stream(1)”/“Stream(2)”/“Stream(3)”/“Stream(4)”
images saved to the SD memory card

IMPORTANT

* Depending on the network environment, download of video data may fail. If downloading failed while
playing images, you may be able to download images after stopping the currently played images and
starting the download again.

* Depending on the network environment and status of the camera, you may not be able to operate each
operation on this screen consecutively.

00:00:00 00:00:10

g

Time & date Duration Event
Sepl07/2016 19:23:30 00:00:10 MN/SC

@ Slider bar
By operating the slider bar, you can select where to start playing images from. The slider bar can only be
used before playing images, or when playing is paused or stopped.

I} (PAUSE) button
Playback will be paused when this button is clicked during playback.

I3 (PLAY) button

When this button is clicked, recorded data will be played.

Note

* [faudioisrecorded, it can be played back, but the image and audio will not be synchronized. Therefore,
images and audio may not always match. When data is being recorded to the SD memory card, audio
may sound as if it is cutting out and the audio quality may be reduced.

*  When recorded audio is played back, the refresh interval of live images and playback may become
slow.

* Recorded audio is not played back when “Off’ or “Interactive(Half-duplex)” is selected for “Audio
transmission mode” on the [Audio] tab of the “Image/Audio” page.

Operating Instructions 39



1 Operations
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23 (FF) button

Each time this button is clicked, the playback speed will change. When the . button is clicked during fast
playback, playback speed will return to the normal playback speed.

Note

* The maximum speed of the fast playback varies depending on the setting of “Bit rate” - “Stream
recording” of the SD memory card.
* Recorded audio will not be played back during fast playback.

. (5s backward) button

Each time this button is clicked, the recorded data goes back by 5 seconds and starts playing.

- (5s forward) button

Each time this button is clicked, the recorded data goes forward by 5 seconds and starts playing.

] (sToP) button

Playback will stop and the “Playback” window will turn to the “Live” page.

[Time & date]
Time and date when each log has been recorded will be displayed.

[Duration]
Displays the period of time that the data has been recorded on the SD memory card.

[Event]

The event type will be displayed.

* MN/SC: Log by “Manual/Schedule”

* TRM1: Alarm by alarm input to Terminal 1
*  TRM2: Alarm by alarm input to Terminal 2
*  TRMS3: Alarm by alarm input to Terminal 3
*  VMD: Alarm by VMD alarm

* COM: Alarm by command alarm

* AUD: Alarm by audio detection alarm

(Start) button

The selected image will be downloaded onto the PC.

Before downloading images, designate the destination directory in advance. (—page 88)

The message window will be displayed to ask if it is OK to start download when the button is clicked. Click
the [OK] button.

Note

* The image playing screen cannot be operated while downloading. Perform operations after the
downloading is completed.

* When the [Cancel] button is clicked in the process of the download, the download will be canceled. In
this case, video data already downloaded before clicking the [Cancel] button will be saved on the PC.

* Video data are saved in the files of approx. 20 MB. When the file size of video data is more than 20
MB, two or more files will be downloaded.

* ltis possible to play back H.264 video data saved on the PC using such applications as Windows
Media® Player. However, we are not liable for performance relating to these applications.
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Depending on the status of the SD memory card or Windows Media Player, H.264 video data cannot
be played back.

For information on playing back H.265 video data, refer to the following Panasonic website below.
https://security.panasonic.com/support/info/
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2 Settings

2.1 About the network security

2.1.1 Equipped security functions

42

The following security functions are featured in this camera.

@ Access restrictions by the host authentication and the user authentication
It is possible to restrict users from accessing the camera by setting the host authentication and/or the user
authentication to “On”. (—page 151, page 154)

(@ Access restrictions by changing the HTTP port
It is possible to prevent illegal access such as port scanning, etc. by changing the HTTP port number.
(—page 158)

® Access encryption by the HTTPS function
It is possible to enhance the network security by encrypting the access to cameras using the HTTPS
function. (—page 178)

IMPORTANT

* Design and enhance security countermeasures to prevent leakage of information such as image data,
authentication information (user name and password), alarm E-mail information, FTP server
information, DDNS server information, etc. Perform the countermeasure such as access restriction
(using the user authentication) or access encryption (using the HTTPS function).

* After the camera is accessed by the administrator, make sure to close the browser for added security.

* Change the administrator password periodically for added security.

* When user authentication (authentication error) has failed to pass 8 times within 30 seconds using the
same |IP address (PC), access to the camera will be denied for a while.
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2.2 Display the setup menu from a PC

The settings of the camera can be configured on the setup menu.

IMPORTANT

* The setup menu is only operable by users whose access level is “1. Administrator”. Refer to
page 151 for how to configure the access level.

2.2.1 How to display the setup menu

1. Display the “Live” page. (—page 10)
2. Click the [Setup] button on the “Live” page.
— The window with the user name and password entry fields will be displayed.

Windows Security [ﬂhJ

The server 192.168.100.11 at Panasonic network device requires a
username and password,

| User name |

| Password |

[7] Remember my credentials

3. Click the [OK] button after entering the user name and the password.
— The setup menu will be displayed. Refer to page 45 for further information about this menu.
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2.2.2 How to operate the setup menu

44

@ Menu buttons
@ Setup page

1. Click the desired button in the frame on the left of the window to display the respective setup menu.
When there are tabs at the top of the “Setup” page displayed in the frame on the right of the window, click
the desired tab to display and configure the setting items relating to the name of the tab.

2. Complete each setting item displayed in the frame on the right of the window.

3. After completing each setting item, click the [Set] button to apply them.

IMPORTANT

When there are two or more [Set], [Register], and [Execute] buttons on the page, click the respective
button to the edited setting item.
<Example>

Internet Event action

UPnP(Auto port forwarding) @ On 0 off
Area --Select the service area—| v @

DDNS
Service

Recommended network setting for internet A setup suitable for internet environment is carried out. @

Set ®

When completing the setting items in field @, click the [Set] button (@) below field (D).

The edited settings in field (@ will not be applied unless the [Set] button (@) below field (D) is clicked.
In the same manner as above, click the [Set] button (@) below field @ when completing the setting
items in field 3.
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2.2.3 About the setup menu window

®@ ® ©

Image Image quality
_Easy Setup Image capture mode 2 mega pixel [16:9](30fps mode;
Internet
Ewvent action "Live" page (Initial display)
{mage/Audio Refresh interval (JPEG) *
Image quality JPEG
LTS Image capture size 1920x1080
+Multi-screen JPEG(1)
+Aam image qualty
+User mng. Image capture size 640x360 @

+Network
+Schedule Image quality

+RS8485 q
Image capture size

+Maintenance JPEG(3)

Image quality

Stream(1)

[Setup] button

Display the “Setup” page.

[Live] button

Display the “Live” page.

[Easy Setup] button

Displays the “Easy Setup” page. The “Easy Setup” page is used to set the connectivity to the Internet, as
well as to set event actions such as alarm settings and camera action on alarm. (—page 47)

[Basic] button

Displays the “Basic” page. The basic settings such as time and date and camera title, and the settings
relating to the SD memory card can be configured on the “Basic” page. (—page 65)

[Image/Audio] button

Displays the “Image/Audio” page. The settings relating to image quality, image capture size, etc. of JPEG/
H.265/H.264 camera images can be configured on the “Image/Audio” page. (—page 90)

[Multi-screen] button

Displays the “Multi-screen” page. The cameras from which images are to be displayed on a multi-screen
can be registered on the “Multi-screen” page. (—page 128)

[Alarm] button

Displays the “Alarm” page. The settings relating to alarm occurrences such as settings for the alarm action
at an alarm occurrence, the alarm occurrence notification, and the VMD area settings can be configured
on the “Alarm” page. (—page 130)

[User mng.] button

Displays the “User mng.” page. The settings relating to the authentication such as users and PCs
restrictions for accessing the camera can be configured on the “User mng.” page. (—page 151)
[Network] button

Displays the “Network” page. The network settings and the settings relating to DDNS (Dynamic DNS),
SNMP (Simple Network Management Protocol), FTP (File Transfer Protocol), the NTP server, and QoS
can be configured on the “Network” page. (—page 156)
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46

[Schedule] button
Displays the “Schedule” page. On the “Schedule” page, it is possible to designate time zones to allow to
activate the VMD detection function. (—page 201)

[RS485] button

Displays the “RS485” page. (—page 208)

[Maintenance] button

Displays the “Maintenance” page. System log check, firmware upgrade, status check and initialization of
the setup menu can be carried out on the “Maintenance” page. (—page 210)

Camera title

The title of the camera whose settings are currently being configured will be displayed.

Setup page

Pages of each setup menu will be displayed. There are tabs for some setup menus.

The bottom of the settings page has been omitted.
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2.3 Use Easy Setup [Easy Setup]

The “Easy Setup” page uses simple operations to set the following:

— Make the camera image available on the Internet

— Set event actions such as recording of a schedule/alarm to the SD memory card
The “Easy Setup” page consists of the [Internet] tab and [Event action] tab.

2.3.1 Configure the Internet settings [Internet]

Click the [Internet] tab of the “Basic” page. (—page 43, page 44)
The settings relating to UPnP (Auto port forwarding), DDNS (Viewnetcam.com), and network settings for the
Internet can be configured on this page.

Internet Event action

UPnP(Auto port forwarding) ® On O Off

Area --Select the service area-—| V|

Service

DDNS

Recommended network setting for internet A setup suitable for internet environment is carried out.

Set

[UPnP (Auto port forwarding)]

Select “On” or “Off” to determine whether or not to use the port forwarding function of the router.
To use the auto port forwarding function, the router in use must support UPnP and the UPnP must be enabled.
* Default: Off

Note

* Due to auto port forwarding, the port number may sometimes be changed. When the number is
changed, it is necessary to change the port numbers registered in the PC and recorders, etc.

* The UPnP function is available when the camera is connected to the IPv4 network. IPv6 is not
supported.

* Tocheckif auto port forwarding is properly configured, click the [Status] tab on the “Maintenance” page,
and check that the “Enable” is displayed for “Status” of “UPnP”. (—page 212)
When “Enable” is not displayed, refer to “Cannot access the camera via the Internet.” in
3.3 Troubleshooting.

*  When the “UPnP (Auto port forwarding)” setting is changed, the “Auto port forwarding” setting under
“UPnP” on the [Advanced] tab of the “Network” page also changes to the same setting.

[Area]

Select the region where the camera is installed.
Global/Japan

Note

e If the camera is used in Japan, select “Japan”. If the camera is used outside of Japan, select
“Global”. The “Viewnetcam.com” service that is displayed when “Global” is selected cannot be used in
Japan.
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[Service]

Select “Viewnetcam.com” or “Off” to determine whether or not to use “Viewnetcam.com”.

By selecting “Viewnetcam.com” and clicking the [Set] button, the registration window for “Viewnetcam.com”
will be displayed in a newly opened window.

Follow the on-screen instructions to register with “Viewnetcam.com”.

Refer to page 197 or the “Viewnetcam.com” website (http://www.viewnetcam.com/) for further information.
* Default: Off

Note

*  When the “DDNS” setting is changed, the “DDNS” setting on the [Advanced] tab of the “Network” page
also changes to the same setting.

[Recommended network setting for internet]

The recommended settings for connecting to the Internet are performed here.
By clicking the [Set] button, a dialog displaying how the following settings will change is displayed.
Click the [OK] button after checking the settings to change the settings to the displayed values.
— [Image] tab on the “Image/Audio” page

[JPEG(1)]

[Image capture size]: VGA/640x360

[JPEG(2)], [JPEG(3)]

[Image capture size]: QVGA/320x180

[Stream(1)])/[Stream(2)]/[Stream(3)]/[Stream(4)]

[Internet mode (over HTTP)]: On

[Transmission priority]: Best effort

[Max bit rate (per client)*]: 1024 kbps

[Stream(1)]

[Image capture size]: 1280x960/1280x720

[Stream(2)]

[Image capture size]: VGA/640x360

[Stream(3)], [Stream(4)]

[Image capture size]: QVGA/320x180
— [Network] tab on the “Network” page

[Common]

[Max RTP packet size]: Limited(1280byte)

[HTTP max segment size(MSS)]: Limited(1280byte)

2.3.2 Configure an event action [Event action]

48

Click the [Event action] tab in the “Easy Setup” page. (—page 43, page 44)

Operating Instructions


http://www.viewnetcam.com/
http://www.viewnetcam.com/

2 Settings

The current settings are displayed here.

Internet Event action

[Current settings]

Alarm
Alarm condition
Alarm
Output terminal

E-mail notification

Schedule

Schedule

You can set event actions for SD schedule recording/FTP periodic image transmission/alarm detection. Once
the settings are completed in each setup menu, click the [Next] button to proceed.
The setup flow is as follows.

Note
* If you click the [Next] button, the settings in the screen will be saved.
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Flow of event action setup

Alarm
(—page 48)

Schedule
(—page 59)

¥

Terminal/VMD/Audio detection

$ $

4 4
4 4
¥ ¥

FTP img. trans. SD memory SD memory FTP periodic
(—page 54) recording: recording: image
JPEG/H.265/H. H.265/H.264 transmission
264 (—page 59) (—page 61)
(—page 54)
Settings of Settings of Settings of Settings of
image transfer recording recording image transfer
conditions conditions conditions method
FTP settings ‘

$ $

Alarm output (terminal)

¥

ceeaa

E-mail settings

Schedule settings

¥

¥

Completed

Completed
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2.3.2.1 Configure the schedule/alarm (event function type setup menu)

Here, select the function type of the event.

Internet Event action

Select an event that triggers the event action.
When it is needed to format the SD memory card, click the [Execute] button

Trigger

SD memory card format

[Trigger]

* Alarm: Select when setting the alarm detection settings.

* Schedule: Select during “SD memory recording” or “FTP periodic image transmission”.
* Default: Alarm

[SD memory card format] E25D €2 &P

To format the SD memory card, click the [Execute] button.

Once you click the [Execute] button, the “Format” confirmation screen will be displayed.
If you click the [OK] button, the formatting will start.

Once the “Format” completion screen is displayed, press the [E= button.

IMPORTANT
* All data saved on the SD memory card will be deleted when the SD memory card is formatted.

* Do not turn off the power of the camera during formatting.

[Next] button

If you select “Alarm”, and click the [Next] button, the alarm setup menu will be displayed. (—page 51)
If you select “Schedule”, and click the [Next] button, the schedule function type setup menu will be displayed.
(—page 59)

2.3.2.2 Alarm: Configure the terminal and VMD (alarm setup menu)

The settings relating to actions when an alarm is detected can be configured in this section.

Alarm
Terminal 1
Terminal 2

Terminal 3

VMD alarm @ On

Audio detection alarm ®0On

Alarm deactivation time _ s (5-600s)
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Alarm
[Terminal 1] «7IpX S22x1 X S21x1J

Determine how to use terminal 1.

* Off: Not used.

e Alarm input(TRM1): Receives terminal alarm input.

— Close: An alarm is detected when the terminal status is changed to “On”.
— Open: An alarm is detected when the terminal status is changed to “Off”".

* Black & white input: Receives the black & white input. (When the input is set to “On”, the black & white
mode is activated)

* Auto time adjustment: Receives time setting through terminal input. When the signal is entered, if the
time difference from the hour (every hour) is less than 29 minutes, the time is adjusted to 00 minutes 00
seconds. The time is not changed in operations which reset the time under 5 seconds. If you select auto
time adjustment, the pull-down menu to select close or open is displayed.

— Close: Performs auto time adjustment when the terminal status is changed to “Close”.
— Open: Performs auto time adjustment when the terminal status is changed to “Open”.
* Default: Off

[Terminal 2] 7R S22x1 K S21x1 2

Determine how to use terminal 2.

* Off: Not used.

e Alarm input(TRM2): Receives terminal alarm input.
— Close: An alarm is detected when the terminal status is changed to “On”.
— Open: An alarm is detected when the terminal status is changed to “Off”".

* Alarm output: Alarm output will be carried out according to the settings for “Output terminal” (—page
132).

* Default: Off

[Terminal 3] CPETRR S22x1 K S21x1 2

Determine how to use terminal 3.
* Off: Not used.
* Alarm input(TRM3): Receives terminal alarm input.
— Close: An alarm is detected when the terminal status is changed to “On”.
— Open: An alarm is detected when the terminal status is changed to “Off”.
* AUX output: AUX output is carried out. The [AUX] button will be displayed on the “Live” page.
* Default: Off

VMD alarm

¢ On: If the VMD area is not configured, the entire region is configured. To configure the VMD area, use the
[VMD area] tab on the “Alarm” page. (—page 142)

* Off: Disables all VMD states.

* Default: Off

[Audio detection alarm]

* On: Ifaudio detection is not configured, set audio detection to “On”. To set the sensitivity of audio detection,
set using the [Audio detection] tab on the “Alarm” page. (—page 144)

» Off: Disables audio detection.

* Default: Off
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[Alarm deactivation time]
Set the duration for which detection is not to be performed after an alarm has been detected. For example, by
using this function you can prevent mail from being sent too often when the E-mail notifications are configured
to be sent to cellular phones when an alarm is detected.
5 — 600 seconds
* Default: 5s

Note

* The duration of the alarm deactivation time can be specified for each type of alarm. For example,
during the time when detections for “Terminal alarm 1” are not made, detections for “VMD alarm”
can be made.

[Next] button
If you click the [Next] button, the alarm function type setup menu will be displayed. (—page 53)

Note
* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the event function type setup menu will be displayed. (—page 51)

2.3.2.3 Alarm: Configure the alarm function type (Alarm function type
setup menu)

Select the alarm function type as “FTP img. trans.” or “SD memory recording”.

Trigger FTP img. trans

Recording format (H.265/1920%1080)

[Trigger]
* FTP img. trans.: When an alarm occurs, performs FTP transfer of the JPEG image.

+  SD memory recording & €& : When an alarm occurs,

records the image to the SD memory card.

Note
*  “FTP img. trans.” for when an alarm occurs and “FTP periodic image transmission” can both be
performed simultaneously.
* If both “FTP img. trans.” for when an alarm occurs and “FTP periodic image transmission” are set,
“FTP img. trans.” will be given priority when an alarm occurs.

[Recording format] L 5221 X S21x1 ]

When “SD memory recording” is selected for “Trigger”, “JPEG(1)”, “JPEG(2)”, “JPEG(3)”, “Stream(1)”,
“Stream(2)”, “Stream(3)”, or “Stream(4)” can be selected for the stream encoding format for the recorded
image.

Operating Instructions 53



2 Settings

[Next] button
If you select “FTP img. trans.” for “Trigger” and click the [Next] button, the FTP transfer setup menu will be
displayed. (—page 54)
If you select “SD memory recording” for “Trigger”, select “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” for “Recording
format”, and then click the [Next] button, the JPEG recording setup menu will be displayed. (—page 55)
If you select “SD memory recording” for “Trigger”, select “Stream(1)”, “Stream(2)”, “Stream(3)”, or
“Stream(4)” for “Recording format”, and then click the [Next] button, the video recording setup menu will be
displayed. (page 56)
Note

* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button the alarm setup menu will be displayed. (—page 51)

2.3.2.4 Alarm: Configure the details for image transfer or recording
conditions
(@ Set FTP transfer (FTP transfer setup menu)

FTP transfer when an alarm is detected is set in this section.

FTP
Alarm image FTP transmission
Directory name

File name Terminal 1 Terminal 2 Terminal 3
VMD Audio detection

FTP transmission retry ® On 9 off

e Transmission interval ~ Maximum number of images  Recording duration
Te alarm
= 0s

Transmission interval Number of images Recording duration
] 100s

Image capture size (640x360)

Image compression rate upon alarm
detection

Post alarm

Image quality upon alarm detection

FTP server add
EENETTELES Example of entry: 192.168.0.10
User name

Password

Control port BN (1-65535)

FTP mode O Passive ® Active

Refer to page 166 for information about how to set the above screen. For information about “Image
compression rate upon alarm detection” and “Image quality upon alarm detection”, refer to “2.7.4.1 Configure
settings relating to image quality on alarm action”.
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[Next] button
If you select “Alarm output” in the alarm setup menu and click the [Next] button, the alarm output setup menu
will be displayed. (—page 57)
If you click the [Next] button in the alarm setup menu without selecting “Alarm output”, the mail setup menu
will be displayed. (—page 57)
Note

* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the alarm function type setup menu will be displayed. (—page 53)

@ Configure SD memory recording (JPEG) (JPEG recording setup menu)
L S22x1 N S21x1 ]

The SD memory recording (JPEG) when an alarm is detected is configure in this section.

JPEG recording(Alarm)

File name

Image saving interval/Number of images to be ~ IMmage saving interval Number of images to be saved
saved(Pre alarm)

Image saving interval/Number of images to be  Image saving interval Number of images to be saved

saved(Post alarm)

Refer to page 76 of 2.4.2 Configure the settings relating to the SD memory card [SD memory card]
[ S11x1 ] 25D €75 €& for information about how to set the above screen.

[Next] button

If you select “Alarm output” in the alarm setup menu and click the [Next] button, the alarm output setup menu
will be displayed. (—page 57)

If you click the [Next] button in the alarm setup menu without selecting “Alarm output”, the mail setup menu
will be displayed. (—page 57)

[Back] button

If you click the [Back] button, the alarm function type setup menu will be displayed. (—page 53)
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® Configure SD memory recording (H.265 or H.264) (video recording setup
menu) &7 522x1 XK S21x1J

56

The SD memory recording (H.265 or H.264) when an alarm is detected is configured in this section.

Stream recording(Alarm)

Audio recording

Frame rate®
Pre alarm (recording) duration

Post alarm (recording) duration

[Audio recording]

Select On/Off to determine whether or not to record audio data.
* On: Saves audio data to videos (MP4 format).
* Off: Does not save audio data to videos (MP4 format).

Note

* This setting is not available when “Interactive(Half-duplex)” is selected for “Audio transmission
mode”.

[Frame rate]
Select a frame rate for the H.265 (or H.264) to be recorded.

Note

* Refer to [Frame rate*] in “2.3.2.8 Schedule: Set SD memory recording (video recording setup menu)
S E25xD €72 €A’ for information about available frame rates and the bit
rates that are set according to the frame rate.

[Pre alarm (recording) duration]

Determine whether or not to perform the pre alarm recording. Set the duration to save image data on the SD
memory card.

Off/ 1s/ 2s/ 3s/ 4s/ 5s/ 8s/ 10s/ 15s/ 20s/ 25s/ 30s/ 40s/ 50s/ 60s

* Default: Off

Note

* The values change depending on the bit rate and the image capture size of the recorded stream. As
the selected bit rate increases, the available maximum value for the pre alarm duration decreases.

[Post alarm (recording) duration]

Set the duration to save image data on the SD memory card after an alarm occurrence.

10s/ 20s/ 30s/ 40s/ 50s/ 60s/ 120s/ 180s/ 240s/ 300s

* Default: 30s

* The actual recording time may sometimes be longer than the duration selected for this setting.

[Next] button

If you select “Alarm output” in the alarm setup menu and click the [Next] button, the alarm output setup menu
will be displayed. (—page 57)

If you click the [Next] button in the alarm setup menu without selecting “Alarm output”, the mail setup menu
will be displayed. (—page 57)
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* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the alarm function type setup menu will be displayed. (—page 53)

2.3.2.5 Alarm: Configure the output terminal &25xD
L 522x1 _J S21x1 2

Alarm output is configured in this section.
* To configure settings relating to the output terminal:

Output terminal
Terminal output upon alarm detection ®0n Q off
SD memory card error ®0On O off

Terminal state upon alarm detection © Latch ® Pulse

Terminal action upon alarm detection ® Open @ Close

Pulse output width N s (1-120)

Refer to page 132 for information about how to configure the above screen.

[Next] button
If you click the [Next] button, the mail setup menu will be displayed. (—page 57)

Note
* If you click the [Next] button, the setting items in the screen are saved.

[Back] button

If you click the [Back] button, either the FTP transfer setup menu (—page 54), the JPEG recording setup menu
(—page 55), or the video recording setup menu (—page 56) will be displayed.

2.3.2.6 Alarm: configure the mail notifications and mail server

The settings relating to e-mail can be configured in this section.
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* To configure e-mail related settings:

E-mail nofification

E-mail notification ® On

Alarm image attachment ® On

Image capture size (640x360)

SMTP ddress
server address Example of entry: 192.168.0.10

SMTP port (1-655635)

e PR Example of enlry- 192.168.0.10

Type @ None ® POP before SMTP ® sMTP
Authentication User name

Password
Sender's E-mail address

SSL

Destination of notification Destination E-mail add|

——

Address 1 M Terminal 1 erminal 2 M Terminal 3
HvMD M Audio detection

———

Address 2 M Terminal 1 M Terminal 2 M Terminal 3
HvMD M Audio detection

fatEEDE M Terminal 1 M Terminal 2 M Terminal 3
HvMD M Audio detection

Address 4 M Terminal 1 M Terminal 2 M Terminal 3
N VMD io detection
M Use the camera titte B Cause of alarm

E-mail subject |

Cause of alarm Occurrence time

E-mail body

Refer to page 161 for information about how to configure the above screen.

[Set] button
If you click the [Set] button, setup will be completed.

[Back] button

If you click the [Back] button, either the FTP transfer setup menu (—page 54), the JPEG recording setup menu
(—page 55), the video recording setup menu (—page 56), or the alarm output setup menu (—page 57) will be
displayed.
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2.3.2.7 Schedule: Configure SD recording or FTP periodic image
transmission (schedule function type setup menu)

Here, the schedule type is selected as “SD memory recording” or “FTP periodic image transmission”.

Trigger SD memary recording|v|
ecording format (H.2 0x1080)

[Trigger]
+  SD memory recording G25xD €& €3 : Records the H.265 (or

H.264) image in the SD memory card at the scheduled time.
* FTP periodic image transmission: Transmits the JPEG image to the FTP server at the scheduled time.

[Recording format] CZETIRR S22x1 L S21x1 2

When “SD memory recording” is selected for “Trigger”, “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)”
can be selected for the recorded image.

[Next] button

If you select “SD memory recording” and click the [Next] button, the video recording setup menu will be
displayed. (—page 59)

If you select “FTP periodic image transmission” and click the [Next] button, the FTP periodicimage transmission
setup menu will be displayed. (—page 61)

Note
* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the event function type setup menu will be displayed. (—page 51)

Note

* “FTP periodic image transmission” and “FTP img. trans.” for when an alarm occurs can both be
performed simultaneously.
* If you select “SD memory recording”, the “FTP periodic image transmission” setting will be canceled.

2.3.2.8 Schedule: Set SD memory recording (video recording setup
menu) 7SI S22x1 L S21x1 2

Here, SD memory recording (H.265 or H.264) is configured according to the schedule.

Stream recording

Audio recording

Frame rate®

Overwrite
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[Audio recording]

Determine whether or not to perform audio recording.

* On: Saves audio data to videos (MP4 format).

e Off: Does not save audio data to videos (MP4 format).
* Default: Off

Note

* This setting is not available when “Interactive(Half-duplex)” is selected for “Audio transmission
mode”.

IMPORTANT

* When the [Overwrite] setting is changed from “Off” to “On”, if the remaining capacity of the SD memory
card is low, old images may be deleted in order to prepare to save new images.

[Frame rate*]
Select a frame rate for the H.265 or H.264 to be recorded from the following.
1fps/ 3fps/ 5fps*/ 7.5fps*/ 10fps*/ 12fps*/ 15fps*/ 20fps*/ 30fps*
e Default: 30fps*
Note
* If you click the [Next] button, the “Transmission priority” will be set to “Frame rate”. (—page 95)

The bit rate is set as follows depending on the selected image capture size and frame rate.
Unit: kbps

Image capture Frame rate (fps)
size 1 3 5 7.5 10 12 15 20 30
320x180 128 | 256 | 256| 256 | 256 | 256 | 256 | 256 | 384
QVGA 128 | 256 | 256| 256 | 256 | 256 | 256 | 256 | 384
400x300 128 | 256 | 256| 256| 256 | 384| 384| 384 | 384
640x360 256 | 384 | 384| 384 384| 384| 384 384| 512
VGA 256 | 384 | 384| 384 384| 384| 384 384| 512
800x600 384 | 512| 512| 512| 768| 768| 768 | 768 | 1024
1280x720 384 | 512| 512| 512| 768 | 768 | 768 | 1024 | 1536
1280x960 512 | 768 | 768 | 768 | 768 | 1024 | 1024 | 1024 | 1536
1920x1080 768 | 1024 | 1024 | 1024 | 1536 | 1536 | 1536 | 2048 | 2048
2048x1536 1024 | 1536 | 1536 | 1536 | 2048 | 2048 | 2048 | 2048 | 3072
[Overwrite]

Determine whether or not to overwrite images when the remaining capacity of the SD memory card becomes

insufficient.

*  On: Overwrites when the remaining capacity of the SD memory card becomes insufficient. (The oldest
image is the first to be overwritten.)

* Off: Stops saving images on the SD memory card when the SD memory card becomes full.
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* Default: Off

IMPORTANT

*  When the [Overwrite] setting is changed from “Off” to “On”, if the remaining capacity of the SD memory
card is low, old images may be deleted in order to prepare to save new images.

[Next] button

If you click the [Next] button, the setup menu to set the schedule for recording into the SD memory card will
be displayed. (—page 61)

[Back] button

If you click the [Back] button, the schedule function type setup menu will be displayed. (—page 59)

* To configure the schedule settings:

Schedules

Schedule mode VMD permission
Schedule 1
(white) - MiMon MiTue MWed MThu MFri IMSat
ime range
mon [N O - S EE

Schedule mode VMD permission

Schedule 2
(Blue) FiMon MTue MWed MThu ¥Fi Eisat

Time range
w0 OO Y - 6
Schedule mode FTP periodic image transmission

Schedule 3

(Green) [l Hion MTue Mwed MThu BFi HSat

Time range

% 24h B I - [~ o I
Schedulsmode
Schedule 4

(Red) Mmon MTue Mwed MThu BFi M Sat

Time range
M 24h I - [~ 8 I
Schedule 5
(Black) Hion MTue MWed BMThu HFi HSat

Time range o .l - |

Set Back

Refer to page 201 for information about how to set the above screen.

[Set] button
If you click the [Set] button, setup will be completed.

[Back] button
If you click the [Back] button, the (video recording setup menu will be displayed. (—page 59)

Note
* Video recording is not performed if “SD memory recording” is not selected in the “Schedule mode”.

2.3.2.9 Schedule: Configure FTP periodic image transmission (FTP

periodic image transmission setup menu)

The FTP periodic image transmission is configured in this section.
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* To configure FTP periodic image transmission settings:

FTP periodic image transmission
FTP periodic image transmission

Directory name

File name

O Name witime&date ® Name wio ime&date
Transmission interval
Image capture size (640x360)

FTP server add,

server address Example of entry- 192 168010
User name
Password

Control port [ (1-65535)

FTP mode O Passive ® Active

Refer to page 166 for information about how to configure the above screen.

[Next] button
If you click the [Next] button, the setup menu to set the FTP periodic image transmission schedule will be
displayed. (—page 63)

Note
* If you click the [Next] button, the setting items in the screen are saved.

[Back] button
If you click the [Back] button, the schedule function type setup menu will be displayed. (—page 59)
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* To configure FTP periodic image transmission schedule settings:

Schedule

Schedules

Schedule mode

Schedule 1

white) [l
Time range

Schedule mode

Schedule 2
(Blue)
Time range

Schedule mode
Schedule 3
(Green)
Time range

Schedule mode
Schedule 4

(Red)
Time range

Schedule mode
Schedule 5

(Black)
Time range

Refer to page 201 for information about how to set the above screen.

[Set] button

M Mon
M 24h

M Mon
M 24h

M Mon
M 24h

M Mon
M 24h

M Mon
M 24h

HTue BMWed BMThu BFi HSat

-

HTue BMWed BMThu BFi HSat

(H e "

HTue HMWed MThu BFi HSat

J - T - [ - Ty |

HTue BMWed MThu BFi Hsa

J - T - [ Ty |

HTue BMWed MThu BFi Hsa

J - T - [ Ty |

12:00 18:00

If you click the [Set] button, setup will be completed.

[Back] button

2 Settings

If you click the [Back] button, the FTP periodic image transmission setup menu will be displayed.

(—page 61)
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* FTP periodic image transmission will not be performed when “FTP periodic image transmission” is
not selected in “Schedule mode”.
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2.4 Configure the basic settings of the camera
[Basic]

The basic settings such as camera title, time and date, SD memory card and the logs can be configured on
the “Basic” page. The “Basic” page has the [Basic] tab, the [Internet] tab, the [SD memory card] tab, and the
[Log] tab.

2.4.1 Configure the basic settings [Basic]

Click the [Basic] tab on the “Basic” page. (—page 43, page 44)
The settings such as the camera title, time and date, etc. can be configured on this page.

SD memory card

Menu language

Camera title
Dateftime display Con ® off
Time display format
Tormat
Dateltime position

Time & date NTP NTP >>

Time zone (GMT+03:00) Osaka, Sapporo. Tokyo
Summer time

o 5 v

(daylight saving) m

Month D Til
sunumetcte g el ) ] SRS

End time & date

Camera title on screen display

Camera title on screen

Camera title position

0sD

Character size

Brightness status display

Image rotation
Stabilizer

Indicator

Status update mode

Status reception port

Viewer software
(nwcv4Ssetup.exe)

Audio out

Monitor out

Automatic installation

Smoather live video
display on the
browser (buffering)
Contrast
enhancement (RGB:0
to 255)

[Menu language]
Select the language to initially display when the camera is accessed from the following.

Month Day Time
®0n O off
I

100%)| |
Con ® off
®0n O off

Con ® Off

@ Polling(30s) © Real time

(ress36)

Gon

Con

®0n

O Audio ® Monitor

@nNTSC ® PAL
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Auto/English/Japanese/Italian/French/German/Spanish/Chinese/Russian/Portuguese

* Auto: The language used by the browser is automatically selected. If the language used by the browser
is not supported by the camera, English is selected.

* Default: Auto

The language displayed on the “Live” page can also be changed. (—page 13)

Note

*  When Japanese is selected, diagnostic e-mails and the screens in cellular phones are displayed in
Japanese.
When Chinese is selected, the screens in cellular phones are displayed in Chinese.
When any other language is selected, diagnostic e-mails and the screens in cellular phones are
displayed in English.

[Camera title]

Enter the title of the camera. Click the [Set] button after entering the title of the camera. The entered title will
be displayed in the “Camera title” field.

* Available number of characters: 0 - 20 characters

* Unavailable characters: " &

e Default: The model No. is displayed.

[Date/time]

Enter the current time and date. When “12h” is selected for “Time display format”, “AM” or “PM” can be selected.
* Available range: Jan/01/2013 00:00:00 - Dec/31/2035 23:59:59

IMPORTANT

* Use an NTP server when the more accurate time & date setting is required for the system operation.
(—page 170)

[Date/time display]

Select On/Off to determine whether or not to display the date and time on an image. To hide the date and time,
select “Off”.

e Default: On

[Time display format]
Select the time display format from “24h” and “12h”. Enter the current hour reflecting this setting when entering

the current time and date for “Date/time”.
¢ Default: 24h

[Date/time display format]

Select a date/time display format. When “2016/04/01 13:10:00” is set for “Date/time” after selecting “24h” for
“Time display format”, time & date will be respectively displayed as follows.

*  DD/MM/YYYY: 01/04/2016 13:10:00

* MM/DD/YYYY: 04/01/2016 13:10:00

*  DD/Mmm/YYYY: 01/Apr/2016 13:10:00

*  YYYY/MM/DD: 2016/04/01 13:10:00

*  Mmm/DD/YYYY: Apr/01/2016 13:10:00

* Default: Mmm/DD/YYYY

[Date/time position]

Select the position to display the time and date in an image.

* Upper left: The information will be displayed at the upper left corner of the screen.
* Lower left: The information will be displayed at the lower left corner of the screen.
* Upper center: The information will be displayed at the upper center of the screen.
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* Lower center: The information will be displayed at the lower center of the screen.

* Upper right: The information will be displayed at the upper right corner of the screen.
* Lower right: The information will be displayed at the lower right corner of the screen.
* Default: Upper left

Note

*  Only upper left or lower left can be configured for the OSD display position when “90 °” or “270 °” is
selected for “Image rotation”.

[NTP]
When “NTP >>" is clicked, the [Advanced] tab of the “Network” page will be displayed. (—page 170)

[Time zone]

Select a time zone corresponding to the location where the camera is in use.
* Default: (GMT +09:00) Osaka, Sapporo, Tokyo

[Summer time (daylight saving)]

Select “In”, “Out” or “Auto” to determine whether or not to apply daylight saving time. Configure this setting if

the summer time (daylight saving time) is applied in the location where the camera is in use.

* In: Applies summer time. An asterisk (*) will be displayed on the left side of the displayed time and date.

*  Out: Does not apply summer time.

* Auto: Applies summer time in accordance with the settings for “Start time & date” and “End time &
date” (month, week, day of the week, time).

* Default: Out

[Start time & date] [End time & date]

When “Auto” is selected for “Summer time (daylight saving)”, select the time & date for the start time and the
end time (month, week, day of the week, time).

[Camera title on screen]

Select “On” or “Off” to determine whether or not to display the camera title on the screen. When “On” is selected,
the character string entered for “Camera title on screen” will be displayed at the position selected for “Camera
title position”.

* Default: Off

[Camera title on screen]

Enter a character string to be displayed on the image.

* Available number of characters: 0 - 20 characters

* Available characters: 0-9, A-Z, a-z and the following marks.
I"#$% &' ()*+,-./:;="

* Default: None (blank)

[Camera title position]

Select the position where the character string is displayed on the screen.

* Upper left: The character string will be displayed in the upper left part of the screen.

* Lower left: The character string will be displayed in the lower left part of the screen.

* Upper center: The character string will be displayed in the upper center part of the screen.
* Lower center: The character string will be displayed in the lower center part of the screen.
* Upper right: The character string will be displayed in the upper right part of the screen.

* Lower right: The character string will be displayed in the lower right part of the screen.

* Default: Upper left
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*  Only upper left or lower left can be configured for the OSD display position when “90 °” or “270 °” is
selected for “Image rotation”.

[OSD] - [Character size]

Select the character size of the date and time as well as text displayed in the image.
* 100%: Displays in the standard size.

* 150%: Displays in 150% of the standard size.

* 200%: Displays in 200% of the standard size.

* Default: 100%

IMPORTANT

* If the settings for [Date/time position] and [Camera title position] are different, the frame rate may be
lower than the specified value.

» If the settings for [Date/time position] and [Camera title position] are different, characters may be
displayed incorrectly or overlapped depending on the [Character size] setting and the number of
characters used. After completing the settings, confirm the result on the “Live” page.

*  If“150%” or “200%” is selected for [Character size], the frame rate may be lower than the specified
value.

* Depending on the setting and the numbers of characters used for [Character size], and the setting and
image capture size of images for [Image rotation], characters displayed on the screen may be cut off.
After completing the settings, confirm the result on the “Live” page.

[Brightness status display]

Select “On” or “Off” to determine whether or not to display the status of brightness on images displayed on the
“Live” page when adjusting brightness.

* Default: On

[Image rotation]

Set whether or not to rotate the image (JPEG, H.265, or H.264).
e 0 °(Off): Does not rotate the image.

* 90 °: Rotates the image by 90 degrees.

* 180 °(Upside-down): Turns the image upside down.

* 270 °: Rotates the image by 270 degrees.

* Default: 0 °(Off)

IMPORTANT

* The position shifts if the image rotation setting is changed when the following area settings are
configured. Therefore, configure the settings for each area after configuring the image rotation.
— Mask area (—page 111)
— Privacy zone (—page 121)
— VMD area (—page 140)

* If“90 °” or “180 °” is selected for “Image rotation”, depending on the “Character size” setting and the
number of characters used, characters displayed on the screen may be cut off.

*  When “3 mega pixel [4:3](30fps mode)” or “1.3 mega pixel [4:3](30fps mode)” is selected for “Image
capture mode”, “90 °” and “270 °” cannot be selected.

[Stabilizer]

Select “On” or “Off” to determine whether or not to activate the image stabilizer. This is not available when “2
mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image capture mode”.
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* Default: Off

Only use the stabilizer function if the camera is installed in an environment that is subject to frequent vibrations.
The stabilizer function can reduce the shaking in images.

Use this function after checking operations when installing the camera.

Do not use the stabilizer function if the camera is installed in an environment that is not subject to vibrations.
If the stabilizer function is used in such a case and there is a moving subject, the stabilizer function will correct
the image and this may cause it to appear as if the entire screen is shaking.

IMPORTANT

If “On” is selected for “Stabilizer”, the view angle will become narrower. When “On” is selected, check
the view angle at camera installation.

If “On” is selected for “Stabilizer”, the noise in images may be increased.

When [Image rotation] is set to “90 °” or “270 °”, “Stabilizer” is not available.

If “On” is selected for “Stabilizer”, “Stream(3)” and “Stream(4)” become “Off”.

If “On” is selected for “Stabilizer”, “Smart Facial Coding” of “Smart Coding” for “Stream(1)” becomes
“Off”.

Depending on the photographic conditions such as in the following situations, images may not be able
to be effectively stabilized.

— When subjects are dark

— When subjects have little contrast, such as walls with a single color

— Subjects with short-cycled image shaking, such as mechanical vibration

— Subjects with large-amplitude image shaking

When capturing images of large subjects that are moving, stabilization may malfunction.

If the settings for “Stabilizer” are changed when the following area settings are configured, the positions
of the configured areas may move out of alignment. Configure each area after configuring
“Stabilizer” settings.

— mask area

— privacy zone

— VMD area

If “On” is selected for “Stabilizer”, the privacy zone moves out of alignment when the stabilizer is
operating. If you will use privacy zone, we recommend not using “Stabilizer”.

If there is shaking in dark environments, image stabilization can become more effective by using a
high-speed shutter setting of “Max. 1/100s” or more for “Maximum shutter”. Configure “Maximum
shutter” according to the installation environment.

When the camera is used in environments of 40°C or higher, the effectiveness of the stabilizer will be
reduced.

[Indicator]

Determine whether or not to use the following indicators. Select “On” to use the following indicators to check
the operational status by lighting them.

— Link indicator (LINK)

— Access indicator (ACT)

— SD memory card error indicator/Auto focus indicator (SD ERROR/AF) &25xD €22

L S21x1 J
— AF indicator (AF) €Z P

— SD memory card error indicator/ABF indicator (SD ERROR/ABF)
* Default: On
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* Link indicator (LINK) (orange): This indicator will light when communication with the connected
device is available.

* Access indicator (ACT) (green): This indicator will blink when accessing a network.

* SD memory card error indicator/Auto focus indicator (SD ERROR/AF) (red) &25xD

G €D : Lights when data cannot be saved to the SD memory card. Also, when the auto
focus function is used, the indicator flashes during focus adjustment and turns off when the adjustment
is completed.

* AF indicator (AF) @€&ZE®: When the auto focus function is used, the indicator flashes during focus
adjustment and turns off when the adjustment is completed.

+ SD memory card error indicator/ABF indicator (SD ERROR/ABF) (red) EEES: Lights
when data cannot be saved to the SD memory card. Also, when the auto back focus function is used,
the indicator flashes during focus adjustment and turns off when the adjustment is completed.

[Status update mode]

Select an interval of the camera status notification from the following.
When the status of the camera changes, the alarm occurrence indication button, [AUX] button @Sk

SRRl (S15x1 ) (S25x1D €224 €&ZEDP, or the “SD recording status indicator’ (XL BRI
S15x1 ] S25x1D €22 €&ZED will be displayed in the “Live” page to notify of the camera status.

* Polling(30s): Updates the status each 30 seconds and provide notification of the camera status.
* Real time: Provide notification of the camera status when the status has changed.
e Default: Real time

Note

* Depending on the network environment, notification may not be provided in real time.

* When multiple cameras are using the same “Status reception port”, even if “Real time” is selected for
“Status update mode”, status notification is not provided in real time. In this case, change the “Status
reception port” settings.

[Status reception port]

When selecting “Real time” for “Status update mode”, designate a port number to which the status change
notification is to be sent.

* Available port number: 1 - 65535

* Default: 31004

The following port numbers are unavailable since they are already in use.

20, 21, 23, 25, 42, 53, 67, 68, 69, 80, 110, 123, 161, 162, 443, 995, 10669, 10670

[Viewer software (nwcv4Ssetup.exe)] - [Automatic installation]
Determine whether or not to install the viewer software from this camera.
* On: Installs the viewer software from the camera automatically.

* Off: The viewer software cannot be installed from the camera.

¢ Default: On

IMPORTANT

* For PCs that do not have the viewer software “Network Camera View 4S” installed, JPEG images are
displayed. You cannot display images using H.265 (or H.264) or send/receive audio to/from the
camera. In order to display H.265 (or H.264) images or send/receive audio to/from the camera, you
must click “Viewer Software” on the “Live” page (—page 13) and then install the viewer software.

* The number of the viewer software installations can be checked on the [Upgrade] tab of the
“Maintenance” page.

Operating Instructions



2 Settings

[Viewer software (nwcv4Ssetup.exe)] - [Smoother live video display on the browser
(buffering)]

Perform settings to display camera images on the viewer software.

* On: Images are temporarily stored on the computer and are displayed smoother.
* Off: Images are displayed in real-time and are not stored on the computer.

* Default: On

[Viewer software (nwcv4Ssetup.exe)] - [Contrast enhancement (RGB:0 to 255)]

Select “On” or “Off” to determine whether or not to enhance the contrast of H.265 images or H.264 images on
the “Live” page.

If “On” is selected, the range of RGB signal on display is extended from 16-235 to 0-255.

When there is a bright part in an image, the intensity may be overexposed. Select a setting suitable to your
usage environment.

* Default: Off

Note

* This setting is only available when viewing images on the “Live” page with Internet Explorer.
* Evenifthis setting is changed, transmitted image data and data saved on the SD memory card are not
changed.

[Audio out] 7Y S22x1 X S21x1 J
Set the Audio/Monitor output format.

Audio/Monitor

* Default: Audio

Note

*  When “Audio out” is set to “Audio”, “Monitor out” cannot be selected.

*  When “Audio transmission mode” is set to anything other than “Off” or “Mic input”, “Audio out” cannot
be set to “Monitor”.

*  When “Audio out” is set to “Monitor”, “Audio transmission mode” can only be set to “Off” or “Mic
input”.

[Monitor out]

Set the image format for images output to an adjustment monitor from the image output terminal (MONITOR
OUT terminal).

NTSC/PAL

* Default: NTSC
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2.4.2 Configure the settings relating to the SD memory card [SD
memory card] | 522x1 3 S21x1 4

Click the [SD memory card] tab on the “Basic” page. (—page 43, page 44)
The settings relating to the SD memory card can be configured on this page.

SD memory card

Operating mode

SD memory card ® Not use
Audio recording @ off
Remaining capacity notification

Overwrite

SD memory card security

Additional info for detecting alteration

Recording stream 1

Recording format (640x360)
FTP periodic image transmission error|v|
Save trigger Terminal 1 Terminal 2 Terminal 3
VMD Command alarm Audio detection

Recording stream 2

Recording format

Save trigger Terminal 1 Terminal 2 Terminal 3
VMD Command alarm Audio detection

SD memory card warning/ error LED

SD memory card waming/ error LED

SD memory card information
Remaining capacity 3572MB/7560MB(Remaining capacity/Original capacity)

Format Execute

SD memery card images

Access img.

Operating mode

[SD memory card]

Select “Use” or “Not use” to determine whether or not to use the SD memory card.
* Default: Use

Note

*  When “2 mega pixel [16:9](60fps mode)” or “1.3 mega pixel [16:9](60fps mode)” is selected for “Image
capture mode”, functions related to SD memory cards are not available. “Not use” will be selected for
“SD memory card”.
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[Audio recording]

Select whether or not to save audio data when saving video data in MP4 format.
* Off: Does not save audio data to videos (MP4 format).

* On: Saves audio data to videos (MP4 format).

* Default: Off

Note

*  When “Audio recording” is used, a stream setting must be selected for “Recording stream 1”, and
“Off” must be selected for “Recording stream 2”.

[Remaining capacity notification]

When the E-mail notification function or the Panasonic alarm protocol function is used to provide notification
of the remaining capacity of the SD memory card, select a level to be notified at from the following.

50%/ 20%/ 10%/ 5%/ 2%

* Default: 50%

Note

* Notification will be provided each time the remaining capacity goes below each of the specified values.
For example, notification will be provided each time the remaining capacity reaches 50%, 20%, 10%,
5% and 2% when “50%” is selected. Notification may not always be made at the very moment when
the remaining capacity of the SD memory card has reached each value.

[Overwrite]

Determine whether or not to overwrite when the remaining capacity of the SD memory card becomes

insufficient.

*  On: Overwrites when the remaining capacity of the SD memory card becomes insufficient. (The oldest
image is the first to be overwritten.)

* Off: Stops saving images on the SD memory card when the SD memory card becomes full.

* Default: Off

IMPORTANT

* Select “Not use” when operating without an SD memory card.

* Before removing the SD memory card from the camera, it is necessary to select “Not use” first. The
recorded data may be corrupted if the SD memory card is removed when “Use” is selected.

*  When an SD memory card is inserted when “Use” is selected, data will be saved in accordance with
the setting of “Save trigger”.

* After inserting the SD memory card, it is necessary to select “Use” to use the SD memory card.

* When the image refresh interval is short, notification/recording timing or interval may become incorrect.
Notification/recording may also not be performed correctly as configured when multiple users are
receiving images. In this case, set the refresh interval longer.

* There are limited times to overwrite on an SD memory card. When having a high frequency of
overwriting, the lifetime of the SD memory card may become shorter.

* Alifetime of an SD memory card should be influenced by the number of the image files stored and log
savings on the SD memory card. Selecting “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” for
“Recording format” can reduce the number of files that can be stored on the SD memory card.

» If the data writing speed goes down after data is repeatedly written on an SD memory card, we
recommend replacing the SD memory card.

¢ When the setting is changed from “Off” to “On”, if the remaining capacity of the SD memory card is low,
old images may be deleted in order to prepare to save new images.
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SD memory card security

[Additional info for detecting alteration]

Select whether or not to add information to enable detection when the data in the SD memory card is altered.
Alteration detection supports video data (MP4 format) only and can be checked using exclusive software.
Click the [Setup>>] button to display the setup menu that can configure the settings relating to additional info
for detecting alteration. The setup menu will be displayed in a newly opened window. (—page 79)

Recording stream 1/Recording stream 2
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[Recording format]

Select the type of image data to be recorded on the SD memory card.

“Off” can only be selected for the “Recording format” of “Recording stream 2”.

“JPEG(1)”, “JPEG(2)”, and “JPEG(3)” can only be selected for the “Recording format” of “Recording stream

17,

* Off: Does not record data.

* JPEG(1): Records still image data (JPEG(1)). The data is recorded in accordance with the settings of
“JPEG(1)” on the [Image] tab of the “Image/Audio” page.

* JPEG(2): Records still image data (JPEG(2)). The data is recorded in accordance with the settings of
“JPEG(2)” on the [Image] tab of the “Image/Audio” page.

* JPEG(3): Records still image data (JPEG(3)). The data is recorded in accordance with the settings of
“JPEG(3)” on the [Image] tab of the “Image/Audio” page.

* Stream(1): Records video data (Stream(1)) in the MP4 video encoding format. The data is recorded in
accordance with the settings of “Stream(1)” on the [Image] tab of the “Image/Audio” page.

* Stream(2): Records video data (Stream(2)) in the MP4 video encoding format. The data is recorded in
accordance with the settings of “Stream(2)” on the [Image] tab of the “Image/Audio” page.

* Stream(3): Records video data (Stream(3)) in the MP4 video encoding format. The data is recorded in
accordance with the settings of “Stream(3)” on the [Image] tab of the “Image/Audio” page.

e Stream(4): Records video data (Stream(4)) in the MP4 video encoding format. The data is recorded in
accordance with the settings of “Stream(4)” on the [Image] tab of the “Image/Audio” page.

* Default:
— Recording stream 1: JPEG(2)
— Recording stream 2: Off

IMPORTANT

e Ifan SD memory card with an SD Speed Class other than 10 is used, 2048x1536 cannot be selected
for the image capture size of JPEG images. Set the maximum combined bit rate of “Stream(1)”,
“Stream(2)”, “Stream(3)”, and “Stream(4)” selected in “Recording format” to 6 Mbps.

* If an SD memory card with an SD Speed Class 10 is used, set the maximum combined bit rate of
“Stream(1)”, “Stream(2)”, “Stream(3)”, and “Stream(4)” selected in “Recording format” to 12 Mbps.

e For SD memory cards with an SD Speed Class 10, use a card that supports UHS-I.

(Ultra High Speed-I)
* Recording stream 2 is not available when a JPEG setting is selected for Recording stream 1.

*  When “Stream(1)” is selected, the settings for “Stream(1)” on the [Image] tab of the “Image/Audio” page
will be changed to the settings for “Stream(1) & recording”.
When “Stream(2)” is selected, the settings for “Stream(2)” on the [Image] tab of the “Image/Audio” page
will be changed to the settings for “Stream(2) & recording”.
When “Stream(3)” is selected, the settings for “Stream(3)” on the [Image] tab of the “Image/Audio” page
will be changed to the settings for “Stream(3) & recording”.
When “Stream(4)” is selected, the settings for “Stream(4)” on the [Image] tab of the “Image/Audio” page
will be changed to the settings for “Stream(4) & recording”.
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*  When using the SD memory recording function of a Panasonic network disk recorder, select
“JPEG(1)” for “Recording format” of “Recording stream 1”.

*  When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the
settings of the following functions may be corrected.
— When “VBR” is selected for “Transmission priority”, “Frame rate” is set.

"«

— When “2s”, “3s”, “4s” or “bs” is selected for “Refresh interval’, “1s” is set.

*  When “On” is selected for “Additional info for detecting alteration”, “Recording format” cannot be
changed to “JPEG(1)”, “JPEG(2)”, or “JPEG(3)".

*  When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the
name of the saved file will be given automatically.

*  When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, the
number of users that can access the camera may be reduced.

e IfJPEG(1)", “UPEG(2)”, or “JPEG(3)” is selected for the “Recording format” of “Recording stream 1”,
and “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for the “Recording format” of
“Recording stream 2”, the maximum bit rate that can be selected for “Stream” is limited.

*  When “On” is selected for “Audio recording”, the maximum value of the available bit rate for “Stream”
will be limited.

*  When “On” is selected for “Additional info for detecting alteration”, the maximum value of the available
bit rate for “Stream” will be limited.

[Save trigger]
Select a trigger to save images on the SD memory card from the following.

FTP periodic image transmission error: Saves images when images have failed to transmit to the FTP
server by the FTP periodic image transmission function. Available only for the “JPEG(1)”, “JPEG(2)”, or
“JPEG(3)” images.

Alarm input: Saves images at an alarm occurrence.

Manual: Saves images manually.

Schedule: Saves images in accordance with the settings for “Schedule” (—page 201). Available only for
the “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” images.

Default:

— Recording stream 1: FTP periodic image transmission error

— Recording stream 2: Alarm input

If you have selected “Alarm input” in the [Save trigger], you can select the alarm type from the following:
¢ Terminal 1: Save the image when an alarm occurs in Terminal 1.

* Terminal 2: Save the image when an alarm occurs in Terminal 2.

* Terminal 3: Save the image when an alarm occurs in Terminal 3.

* VMD: Save the image when motion detection occurs.

* Command alarm: Save the image when a command alarm is entered.

* Audio detection: Save the image when audio detection occurs.

*  When “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is selected for “Recording format”, “FTP
periodic image transmission error” is unavailable.
* To enable alarms to occur, alarm settings must be configured in advance on the [Alarm] tab.

*  When “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” is selected for “Recording format”, “Schedule” is
unavailable.
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JPEG recording(Manual)

JPEG recording{Manual)

File name

Image saving interval

This setting is only available when “JPEG(1)”, “UPEG(2)”, or “JPEG(3)” is selected for “Recording format”, and
“Manual’ is selected for “Save trigger”.

[File name]

Enter the file name used for the image to be saved on the SD memory card. The file name will be as follows.

* File name: [“Entered file name” + “Time and date (year/ month/ day/ hour/ minute/ second)’] + “Serial
number”

* Available number of characters: 1 - 8 characters

* Unavailable characters: " & */:;<>7?\|

[Image saving interval]

When “Manual” is selected for “Save trigger”, select an interval (frame rate) of saving images on the SD memory
card from the following.
0.1fps/0.2fps/0.33fps/0.5fps/1fps

e Default: 1fps

JPEG recording(Alarm)
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JPEG recording(Alarm)

File name

Image saving interval/Number of images to be Image saving interval Mumber of images to be saved

saved(Pre alarm)

Image saving interval/Number of images to be Image saving interval Number of images to be saved
saved(Post alarm)

This setting is only available when “JPEG(1)”, “UPEG(2)”, or “JPEG(3)” is selected for “Recording format”, and
“Alarm input” is selected for “Save trigger”.

[File name]

Enter the file name used for the image to be saved on the SD memory card. The file name will be as follows.

* File name: [“Entered file name” + “Time and date (year/ month/ day/ hour/ minute/ second)’] + “Serial
number”

* Available number of characters: 1 - 8 characters

* Unavailable characters: " & */:; <> 7?\|

[Image saving interval/Number of images to be saved(Pre alarm)] - [Image saving interval]

When “Alarm input” is selected for “Save trigger”, select a pre alarm interval (frame rate) of saving images on
the SD memory card from the following.

0.1fps/0.2fps/0.33fps/0.5fps/1fps

e Default: 1fps

[Image saving interval/Number of images to be saved(Pre alarm)] - [Number of images to be
saved]

Select a number of pre alarm images to be saved on the SD memory card from the following.
Off/1pic/2pics/3pics/4pics/5pics
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* Default: Off

[Image saving interval/Number of images to be saved(Post alarm)] - [Image saving interval]

When “Alarm input” or “Manual” is selected for “Save trigger”, select an interval (frame rate) of saving images
on the SD memory card from the following.
0.1fps/0.2fps/0.33fps/0.5fps/1fps

* Default: 1fps

[Image saving interval/Number of images to be saved(Post alarm)] - [Number of images to be
saved]

Select a number of alarm images to be saved on the SD memory card from the following.
10pics/ 20pics/ 30pics/ 50pics/ 100pics/ 200pics/ 300pics/ 500pics/ 1000pics/ 2000pics/ 3000pics
* Default: 100pics

Stream recording(Alarm)

Stream recording(Alarm)

Pre alarm (recording) duration

Post alarm (recording) duration

This setting is only available when “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)”, is selected for
“Recording format” of the SD memory card, and “Alarm input” is selected for “Save trigger”.

[Pre alarm (recording) duration]

Determine whether or not to perform the pre alarm recording. Set the duration to save image data on the SD
memory card.

Off/ 1s/ 2s/ 3s/ 4s/ 5s/ 8s/ 10s/ 15s/ 20s/ 25s/ 30s/ 40s/ 50s/ 60s/ 90s/ 120s

e Default: Off

Note

* The available values change depending on the bit rate and image capture size for “Stream” selected
for recording. As the selected bit rate increases, the available maximum value for the pre alarm
duration decreases.

[Post alarm (recording) duration]
Set the duration to save image data on the SD memory card after an alarm occurrence.
10s/ 20s/ 30s/ 40s/ 50s/ 60s/ 120s/ 180s/ 240s/ 300s
* Default: 30s
* The actual recording time may sometimes be longer than the duration selected for this setting.

SD memory card warning/error LED

[SD memory card warning/error LED]

Select On/Off to determine whether or not to activate the SD memory card warning/error LED when an SD

memory card warning or error is detected.

SD memory card warning detection conditions: After the total use time has exceeded 6 years and the number

of overwrite times has exceeded 2000

SD memory card error detection conditions: Write error, read error, etc.

* On: When a warning status is detected, the SD memory card error/error LED turns on. When an error
status is detected, the SD memory card error/error LED starts flashing.

* Off: Stops detection of warning or error status.
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¢ Default: Off

SD memory card information
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[Rema

ining capacity]

Total capacity and remaining capacity of the SD memory card will be displayed.
Depending on the status of the SD memory card, the size indications will differ as follows.

Indication Description
———————— MB/--------MB No SD memory card is inserted. Failed to obtain available capacity
due to error, etc.

MB/ MB The SD memory card is unformatted, or locked (write-protected).

Note

*  When “Off” is selected for “Overwrite” and the available size of the SD memory card is “0 MB”, images

will not be saved on the SD memory card. When the notification function is on, a notification will be
sent to the registered addresses and destinations of the Panasonic alarm protocol when the SD
memory card becomes full. (—page 136, page 146)

[Format]

To format the SD memory card, click the [Execute] button.

IMPORTANT

Before formatting the SD memory card, it is necessary to select “Use” for “SD memory card” on the

[SD memory card] tab of the “Basic” page (—page 72) and “Off” for “FTP periodic image

transmission” on the [Advanced] tab of the “Network” page (—page 168).

Use the SD memory card after formatting it using the [SD memory card] tab. If using the SD memory

card that has not been formatted on the [SD memory card] tab, the following functions may not work

correctly.

— Save/obtain images that failed to transmit to the FTP server using the FTP periodic image
transmission function

— Save/obtain alarm images

— Save/obtain images saved manually

— Save/obtain images in accordance with the schedule settings

— Save/obtain the alarm logs, the manual/schedule logs, the FTP error logs and the system logs

— Save/obtain images recorded using the SD memory recording function of Panasonic network disk
recorder

— Play/download images on the SD memory card

When an SD memory card is formatted while another user is in operation, the operation will be

canceled.

It is impossible to access the SD memory card during the process of formatting.

All data saved on the SD memory card will be deleted when the SD memory card is formatted.

Do not turn off the power of the camera during the process of formatting.

After formatting the SD memory card, available size may be smaller than the total size since the default

directory is automatically created in the SD memory card.

Compatible SD memory card (option)

Manufactured by Panasonic (SD speed class 4 or higher)

miniSD and microSD cards cannot be used.

— SDXC memory card: 64 GB, 128 GB

— SDHC memory card: 4 GB, 8 GB, 16 GB, 32 GB

— SD memory card: 2 GB
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* Refer to our website (https://security.panasonic.com/support/info/) for latest information about the
compatible SD memory cards.

*  When repeatedly recording images on an SD memory card using the auto overwrite function, make
sure to use an SD memory card with high reliability and durability.

* Use the SD memory card that complies with UHS-1(Ultra High Speed-1) in the case of SD Speed
Class10.

SD memory card images

[Access img.]

Images on the SD memory card can be obtained. Click the [Execute] button. Refer to page 86 for how to
access images.

2.4.3 Configure the settings relating to alteration detection
[Alteration detection]

Selecting alteration detection enables detection using exclusive software when the data on the SD memory
card is altered.

Alteration detection supports video files (MP4 format) only.

Refer to page 81 for information on how to configure alteration detection.

For further information about exclusive software for alteration detection and how to use it, refer to our website
below.

https://security.panasonic.com/support/info/

Note

*  When Alteration detection is used, a stream setting must be selected for “Recording stream 1”, and
“Off” must be selected for “Recording stream 2”.

Alteration detection

Select cerlificate Pre-installed

Additional info for detecting alteration ®On

Pre-installed ceriificate

Certificate download Execute

CA Cerlificate
CRT key generate Execute

Generate Ceriificate Signing Request Execute

CA Ceriificate install Execute

Information Invalid Confirm Delete

Cerfificate download Execute
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[Select certificate]

Select the certificate to be used with HTTPS.

Pre-installed: Selects a pre-installed certificate.

CA: Selects a “CA Certificate”. Only displayed when the “CA Certificate” is installed.
Default: Pre-installed

[Additional info for detecting alteration]

Select whether or not to give information for alteration detection to video files (MP4 format) to be saved on the
SD memory card.

Note
* When the certificate (CA certificate) issued by CA (Certificate Authority) is not valid, “On” cannot be
selected.

*  When “JPEG(1)”, “JPEG(2)”, or “JPEG(3)” is selected for “Recording format” of “Recording stream
17, “On” cannot be selected.

[Pre-installed certificate - Certificate download]

Click the [Execute] button and download the root certificate for the pre-installed certificate. By installing the
root certificate to your PC, you can get signature verification for the pre-installed certificate.

Note

» Refer to the Panasonic website (https://security.panasonic.com/support/info/) for further information
about how to install certificates on your PC.

[CA Certificate - CRT key generate]

CRT key (encryption key) used for alteration detection is generated. To generate the CRT key, click the
[Execute] button to display “CRT key generate” dialog box.

[CA Certificate - Generate Certificate Signing Request]

When using the CA certificate issued by CA as the CA certificate used for alteration detection, the CSR
(Certificate Signing Request) will be generated.

To generate the CSR, click the [Execute] button to display the “CA Certificate - Generate Certificate Signing
Request” dialog window.

[CA Certificate - Certificate install]

Installs the certificate (CA certificate) issued by CA and displays the information of the installed certificate (CA
certificate).

To install the certificate (CA certificate), click the [Browse...] button to display the [Open] dialog box, and select
the file of the certificate (CA certificate) issued by CA, and click the [Execute] button.

If the certificate (CA certificate) is already installed, the file name of the installed certificate will be displayed.

[CA Certificate - Information]

Displays the information of the certificate (CA certificate) issued by CA.

When the [Confirm] button is clicked, the registered information of the installed certificate (CA certificate) will
be displayed in the “CA Certificate - Confirm” dialog box. If the certificate (CA certificate) is not installed, the
content of the generated CSR file will be displayed.

When the [Delete] button is clicked, the installed certificate (CA certificate) will be deleted.

[CA Certificate - Certificate download]

Downloads the certificate (CA certificate) issued by CA from the camera.
When implementing alteration detection of video data (MP4 files) on the SD memory card using exclusive
software, the downloaded certificate is used.
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2 Settings

IMPORTANT

* Before deleting the valid certificate (CA certificate), confirm that there is a backup file of the certificate
(CA certificate) on the PC or another media. The backup file will be required when installing the
certificate (CA certificate) again.

2.4.4 How to configure alteration detection settings

The settings relating to alteration detection that detects when data in the SD memory card is altered or edited
can be configured on this page.

The alteration detection settings will be configured in the following procedure.

Generation of the CRT key (encryption key)

When using a pre-installed certificate When using the certificate issued by CA

A

Generation of CSR (Certificate Signing Request)

Application for the approval by CA
(Certificate Authority) - Issue of the certificate :

g

'

Installation of the certificate

A

Configuration of the additional info for detecting alteration

2.4.4.1 Generation of the CRT key (encryption key)

IMPORTANT

* When the certificate (CA certificate) issued by CA is valid, it is impossible to generate the CRT key.

* When the certificate (CA certificate) issued by CA is used, the available key size varies depending on
the CA. Check the available key size in advance.

* To generate the CRT key, it may take about 2 minutes. Do not operate the web browser until the
generation of CRT key is complete. While the CRT key is being generated, the refresh interval and line
speed may be lower.
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1. Click the [Execute] button of “CRT key generate”.
— The “CRT key generate” dialog box will be displayed.

Current CRT key

RSA key
size
CRT key .
as

modified

Not generated History

CRT key generate Execute

*Generating a CRT key takes around 2 minutes.

Close

2. Click the [Execute] button.
— The generation of CRT key will be started. When the generation is finished, the key size and generation

Note

time & date of the generated key will be displayed on “Current CRT key”.

To change (or update) the generated CRT key, perform step 1 to 2. The CRT key and certificate issued
by CA are valid in a set. When the CRT key is changed, it is necessary to re-apply for the certificate
issued by CA.

When the CRT key is updated, the log of the previous CRT key is saved. When the [History] button of
“Current CRT key” on the “CRT key generate” dialog box is clicked, the “Previous CRT key” dialog box
will be displayed, and it is possible to check the key size and generation time & date of the previous
key. When the [Apply] button is clicked on the “Previous CRT key” dialog box, it is possible to replace
the current CRT key with the previous one.

Previous CRT key

RSA key

e 2048bit

History

Last
modified

2.4.4.2 Generation of CSR (Certificate Signing Request)
IMPORTANT

If the CRT key is not generated, it is impossible to generate the CSR.

Before generating the CSR file, configure the following settings on [Internet Options] of the web browser

in advance. Click [Internet Options...] under [Tools] of the menu bar of Internet Explorer, and then click

the [Security] tab.

— Register the camera for [Trusted Sites].

— Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable]
radio button of [File Download] under [Downloads].

— Click the [Custom level...] button to open the [Security Settings] window, and check the [Enable]
radio button of [Automatic prompting for file downloads] under [Downloads].
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1. Click the [Execute] button of “CA Certificate - Generate Certificate Signing Request”.
— The “CA Certificate - Generate Certificate Signing Request” dialog box will be displayed.

CA Ceriificate - Generate Certificate Signing Request
Common Name

Country

State

Locality

Organization

Organizational Unit

modified

2. Enter the information of the certificate to be generated.

Item Description Available number of characters
[Common Name] Enter the camera address or host name. 64 characters
[Country] Enter the country name. 2 characters (Country code)
[State] Enter the state name. 128 characters
[Locality] Enter the locality name. 128 characters
[Organization] Enter the organization name. 64 characters
[Organizational Enter the unit name of the organization. 64 characters
Unit]
[CRT key] Displays the key size and generation time & date —

of the current key.

3. Click the [OK] button after entering the items.
— The [Save As] dialog box will be displayed.

4. Enter a file name for the CSR in the [Save As] dialog box to save on the PC.
— The saved CSR file will be applied to the CA.

IMPORTANT

* The certificate will be issued for the set of the generated CSR and CRT key. If the CRT key is
re-generated or updated after applying to the CA, the issued certificate will be invalidated.

Note
* This camera generates the CSR file in the PEM format.
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2.4.4.3 Installation of the certificate issued by CA
IMPORTANT

* Ifthe CSR file is not generated, it is impossible to install the certificate (CA certificate) issued by CA.

* For the installation of the certificate issued by CA, the CA certificate issued by CA is required.

1. Click the [Browse...] button of “CA Certificate - Certificate install”.
— The [Open] dialog box will be displayed.

2. Select the certification file and click the [Open] button. Then, click the [Execute] button.
— The certification will be installed.

Note
* The host name registered in the installed certificate will be displayed on “CA Certificate -
Information”. Depending on the status of the certificate, the following are displayed.
Indication Description
Invalid The CA certificate is not installed.
[Host name of the certificate] The certificate has already been installed and
validated.
Expired The certification has already expired.

* When the [Confirm] button is clicked, the registered information of the installed certificate (CA
certificate) will be displayed in the “CA Certificate - Confirm” dialog box. (Only “Organizational
Unit” will be displayed with an asterisk (*).)

CA Certificate - Confirm
Common Name NWCAM
Country
State
Locality
Organization
Organizational Unit
RSAkey size ~ 2048bit
CRT key
Last modified

* When the [Delete] button is clicked, the installed certificate (CA certificate) will be deleted.

*  When “On” is selected for “Additional info for detecting alteration”, it is impossible to delete the
certificate (CA certificate) issued by CA.

* To change (or update) the certificate issued by CA, perform step 1 and 2.

IMPORTANT

* Before deleting the valid certificate (CA certificate), confirm that there is a backup file of the certificate

(CA certificate) on the PC or another media. The backup file will be required when installing the
certificate (CA certificate) again.

* The expiration date of the certificate issued by CA can be checked by double-clicking the server
certification file issued by CA.
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2.4.4.4 Configuration of alteration detection

1. Select “On” for “Additional info for detecting alteration”, and click the [Set] button.
2. Extensive information for alteration detection will be added to video files (MP4 format) recorded after

changing the setting.
IMPORTANT

* When the “Additional info for detecting alteration” setting is changed, manual recording on the SD
memory card will stop. Start manual saving again as necessary.

Note
* Alteration detection can be performed on video files (MP4 format) recorded when “On” is selected for

“Additional info for detecting alteration” using exclusive software.
For further information about exclusive software and how to use it, refer to our website below.

https://security.panasonic.com/support/info/
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2 Settings

2.4.5 Access copy images saved on the SD memory card onto the
PC [SD memory card images] L 522x1 J S21x1J

Click the [SD memory card] tab on the “Basic” page. (—page 43, page 44)

The following are descriptions of how to copy images saved on the SD memory card onto the PC. Itis necessary
in advance to select “Allow” for “FTP access to camera” on the [Network] tab of the “Network” page.

(—page 156)

IMPORTANT

* |t may sometimes be impossible to operate when another user is accessing images on the SD memory
card. In this case, retry later.

* Depending on the settings of a proxy server or a firewall, images may not be obtained via a network.
In this case, refer to the network administrator.
1. Click the [Execute] button of “SD memory card images”.
— The user authentication window will be displayed.

User authentication

Password I

*It is necessary in advance to select "Allow” for "FTP access to camera” on the [Network] tab of the
"MNetwork" page.

ok Cancel

2. Click the [OK] button after entering the user name and password of the camera administrator.
— The folder in which images are to be saved will be displayed.

Note
*  When the FTP server of the camera is logged to access images, the SD memory card is assigned to
Drive B.
Images are saved in different directories according to “Save trigger”.

Move to the directory corresponding to the desired images and copy them.
Refer to page 238 for further information about the directory structure.
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Possible number of JPEG images that can be saved on the SD memory card
(as indications)

For possible numbers of JPEG images that can be saved on the SD memory card, refer to our website below.
https://security.panasonic.com/support/info/

Possible duration of stream images (H.265 or H.264) that can be saved on
the SD memory card (as indications)

For possible duration of stream images (H.265 or H.264) that can be saved on the SD memory card, refer to

our website below.
https://security.panasonic.com/support/info/
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2 Settings

2.4.6 Configure the directory of the PC that images will be
downloaded to [Log] L 522x1 R S21x1 2

Click the [Log] tab on the “Basic” page. (—page 43, page 44)
The directory of the PC that images recorded on the SD memory card will be downloaded to can be configured
in this section.

SD memory card

Recording stream 1

Name of the destination

directory for downloaded

images

Recording stream 2

Name of the destination

directory for downloaded

images

Recording stream 1

Name of the destination

directory for downloaded

images

Recording stream 2

Name of the destination

directory for downloaded

images

Recording stream 1

FTP periodic image  Name of the destination

transmission error directory for downloaded
images

Manual/Schedule

Alarm

The settings related to the directory of the PC that recorded images of when alarms occur will be downloaded
to can be performed.

[Recording stream 1] - [Name of the destination directory for downloaded images]

Enter the name of the destination directory to which images recorded in the recording stream 1 are to be
downloaded. For example, enter “C:\alarm” to designate the folder “alarm” under drive C.

* Available number of characters: 3 - 128 characters

* Available characters: Alphanumeric characters, the slash (/), the backslash (\), the colon (:) and the
underscore ().

[Recording stream 2] - [Name of the destination directory for downloaded images]

Enter the name of the destination directory to which images recorded in the recording stream 2 are to be
downloaded. For example, enter “C:\alarm2” to designate the folder “alarm2” under drive C.
* Available number of characters: 3 - 128 characters

* Available characters: Alphanumeric characters, the slash (/), the backslash (\), the colon (:) and the
underscore ().

Manual/Schedule

The settings related to the directory name of the PC that images recorded by manual saving or schedule saving
will be downloaded to can be performed.

Designate the destination folder in the same manner as for “Alarm”.

Note

* Schedule saving is available only when “Stream(1)”, “Stream(2)”, “Stream(3)”, or “Stream(4)” is
selected for “Recording format”.
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FTP periodic image transmission error

The settings related to the directory name of the PC that recorded images of when FTP errors occur will be
downloaded to can be performed.
Designate the destination folder in the same manner as for “Alarm”.

IMPORTANT

*  When “Name w/o time&date” is selected for “File name” of “FTP periodic image transmission”on the
[Advanced] tab on the “Ne